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CHAPTER 1 I ntrOdUCtl On
to PMMew
Pro

Welcome to PMView Pro, a graphics viewer/editor/converter for
Windows NT/2000/X P, Windows 95/98/Me, and OS/2 Warp. This
User's Guide will help you learn to use the various features of the
program.

System Requirements

To use PMView Pro, your computer must meet the following mini-
mum requirements:

* Pentium® class processor or higher

e Windows 95/98/Me, Windows NT/2000/XP, or OS/2 Warp

* 16 megabytes of memory

* 10 megabytes of free disk space

Of course, these are minimum requirements to run the program.
Graphics processing can be a very intensive processing and the
memory and CPU requirements might be higher.
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Introduction to PMView Pro

About PMView

PMView isarobust and configurable image viewing, conversion,
and editing tool for bitmapped graphics. It loads your images blaz-
ingly fast, without compromising quality or robustness. PMView
supports saving and loading of more than 40 different file formats,
including JPEG, GIF, PNG, TIFF, and PhotoCD. PMView offers
broader and faster support for these file formats than many other
programs do, since we wrote all of PMView's code for format han-
dling ourselves. PMView also incorporates various image recovery
techniques. If the image is bad, PMView will try to make the best
of the situation and show theimageif only possible. It does not give
up easily.

PMView isintelligent. It tries to figure out what you want instead
of popping up meaningless error messages. It triesto provide good
default settingsfor most actions. PMView isalso very configurable.
There are hundreds of different options that make it possible for
you to configure PMView to your liking. For instance, PMView
has fully configurable shortcut keys.

PMView is much more than aviewer. It has functions for doing
screen captures including the unique feature to capture parts of a
window that are outside the desktop. The print function in PMView
isatrue WY SIWY G (what you isis what you get) implementation
that visually lets you adjust margins and see the printed output.
PMView allows for printing an image using multiple sheets of
paper, enabling the user to print out a huge poster using standard
letter sized paper and gluing the parts together. Naturally, PMView
also has a TWAIN-interface for scanning and advanced batch and
scripting functions that |ets you automate conversion of alarge
number of filesin the background.

PMView has a unique automatic thumbnailing facility that will cre-
ate thumbnails for your images. The thumbnailsin the file open
window make it possible for you to browse through hundreds of
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About PMView

images in minutes. You'll never again have to load a bunch of
images just because you forgot the name of the one you're looking
for. PMView lets you convert files from one file format to another
with the click of amouse button. Just right-click with your mouse
on the file you want to convert and select what format to convert to.
PMView will do the conversion in a background task and lets you
continue working.

PMView also has an easy-to-use dlideshow feature that lets you
create slideshows just by dragging and dropping the images you
want. The dideshow controller gives you an easy way to control
your slideshow while it's running.

PMView iswritten in C++ and makes heavy use of C++ specific
featureslike classes, templates and exception handling. Throughout
this product, we have tried our hardest to provide you with the best
possible performance. Our memory and file management routines
will provide you with blazing speed and the best use of your hard-
ware. PMView does not lay its foundation on third party code or
libraries that would limit our possibilities to provide a robust and
optimized solution.

PMView is dynamically multithreaded, meaning that threads will
be created and destroyed as needed. There will never be threads
spinning in the background doing nothing. We have also invented a
Priority Boost system that will let you useidletime priority without
having to worry about locking up PMView or your system.
PMView works well on single CPU systems, but also includes
advanced SMP features for multi-processor systems.

PMView iseasy to use. It has an object oriented user interface with
well-organized menus. PMView aso comes with full context-sen-
sitive on-line help. Press F1 at any time to obtain context sensitive
help, or select Help from the main menu to get alist of al the help
topics.
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CHAPTER 2 |nSta| |aI| on

This chapter explains how to install PMView Pro on your computer.

Installation for Windows Users

PMView uses a standard Windows installation that you are already
familiar with. To install the program, simply follow these steps:

1. Start the installation program by running the executable file that
you downloaded or received on CD. You will see the welcome
screen:
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Installation

Welcome to the PMView Pro Setup
program. This program will install
PMView Pro on your computer.

Itiz strongly recommended that pou exit all Windows programs
before running thiz Setup Program.

Click Cancel to quit Setup and close any programs you have
nning.  Click Mest to continue with the Setup program .

WARMING: Thiz program iz protected by copyright law and
international treaties.

Unauthorized reproduction or distribution of thiz progran, or any
portion of it, may result in severe civil and criminal penalties, and
will be prozecuted to the maximurn extent pozsible under law.

Cancel |

2. Click the Next button to continue. You will then see the license
agreement for the use of PMView:

License Agreement

Fleaze read the following license agreement. Use the scroll bar ta view the rest of
the agreement.

PMView Pro End User License Agreement ~

SINGLE EMD-USER LICENSE AGREEMENMT FOR Mielsen Software Enterprizes, Inc.@
SOFTWARE IMPORTANT-READ CAREFULLY . Thiz Nielzen Software Enterprizes, Inc. End-
User Licenze Agreement ("ELLA" iz a legal AGREEMENT between you (either as a

redistered individual user or as the registered representative on behalf of a single entity)

and Mielzen Software Enterprises, Inc. for the Mielzen Software Enterprises, Inc. software
product idertified above, which product includes computer software and may include
associated media, printed materialz, and "online” or electronic documentation ("SOFTVWARE
PRODUCT"). By installing, copying, or otherwize using the SOFTWARE PRODUCT, you

aares to ke bound By the terms of this EULA. If wou do not sores to the terms of this EULA.

MOTICE: By clicking | Agree" below, you agree to be bound by all the terms and conditions of the
above End User Licenze Agreement ["ELILA"). Carefully read the EULA before accepting. If you
do not agree with any of the terms and conditions in the EULA, click "Cancel to cancel thiz setup
process, then return the complete package for a refund of any fees paid for this software.

ise Installation ‘Wizard®

< Back Cancel
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Installation for Windows Users

3. If you agree with the terms of the license agreement, click the “|
Agree” button and you will seethe screen that allows you to choose
the location on your hard drive where the program will be installed:

<2 pMView Pro

Destination Location o
" 1

Setup will install PYiew Pro in the following folder.
To inztall into a different folder, click Browse, and select another folder.

*f'ou can chooge not to install PMYiew Pro by clicking Cancel to exit Setup.

Destination Folder

C:\Program Files'\Ph\iew Browse...

ise Installation ‘Wizard®

Cancel |

4. A default directory will belisted. If you wish to change the loca
tion, click the Browse button and you can then select another direc-
tory. Thiswindow will display the amount of free disk space on the
selected hard drive partition and also the amount of free space that

will be available after PMView isinstalled. Ensure that you choose
adisk partition with sufficient free space. When you are finished,
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Installation

click the Next button and you will see the shortcuts screen:

Shortcut Location o
v <

Shortcut location

[v Create a shortcut on the desktop

[v Create shortcuts in the Start Programs menu

These options decide where shortcuts should be created.

Create shortcuts for

" Curent uger

t+ il uzers [Requires Administrator rights

These options decide if the shortcuts should be created for the current user only or for all
uzers. Mote that creating shortcuts for all users requires Administrator rights [wWindows
MT/2000/5P).

ise Installation ‘Wizard®

< Back | Mest » | Cancel |

5. The installation program will, by default, create a PMView short-
cut on your desktop and in your Start Button menu. Unchecking the
boxes will skip the creation of the appropriate shortcut.

If you areinstalling the program under Windows NT/2000/Me/XP,
you can choose to have the shortcuts available for the current user
or for al users. In order to create the shortcuts for all users, you
must have Administrator privileges. Once you have made your
selections, click the Next button to continue to the associations
screen:
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Installation for Windows Users

File Associations

Aszzociating a file format with PhYiew Pro results in that PMWYiew Pra iz launched
when you double click on a file of thiz format.

[V Flexible Image Transport System (FIT, FITS]
¥ Graphics Interchange Format [GIF)

W Windows or 05/2 lcon [IC0)

¥ Electronic Arts [IFF, ILEM, LEM)

¥ Digital Research GEM Paint [IMG]

¥ JFEG File Interchange Format [JPG, JPEG, JFE, JIF, JFIF]
¥ 05/2 Boat Logo [LGO)

¥ tMacPaint [MALC)

W Micrazoft Paint (MSF)

[+ Kadak Phato CD [PCD)

W &dobe Photoshop Docurnent [PSD)

¥ Z5cft Paintbrush [PC)

[ PC Paint/Pictar, Bio-Rad, or Softimage (FIC)
¥ PEMPIuz Portable Bitmap (PEM)

ise Installation ‘Wizard®

Uncheck Al

Cancel |

6. Associations alow you to have PMView automatically start
when you double-click a graphics filein Windows Explorer. By
default, the installation program with associate PMView with all
graphicsfilesthat it supports. If you do not wish to have PMView
associated with a particular type of graphicsfile, simply uncheck
that file type. Press the Next button and you will see the window

that starts the actual installation of files:

Using PMView Pro
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Installation

Start Installation 0

“Y'ou are now ready to install PhWiew Pro.

Prezz the Mext button to begin the ingtallation or the Back button to reenter the installation
infarmation.

ise Installation ‘Wizard®

Cancel |

7. Click the Next button to begin installing PMView onto your hard
drive. Asfiles are copied, a progress window will keep you
updated. Once the files are installed, the final installation window
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Installation for OS/2 Users

42 PMView Pro [Z|
PhiView Pro has been successfully installed.

Press the Finish button to exit this installation.

RS |

8. Press the Finish button to complete the installation. Theinstaller
will then exit and you can start PMView from the Start Menu icon,
or by opening any image whose format is associated with PMView.

Installation for OS2 Users

PMView Pro usesthe WarpIN OS/2 installation program, thisis
new to version 3.0. It is recommended that you either remove any
previous PMView versions from the system, or install to a different
directory to avoid errors. To install the program simply follow these
steps:

1. If you downloaded a Zip file, unzip it in atemporary directory
and then run theinstall.exe file. If you received PMView on CD, all
you haveto doisrun the install.exefile. You will then see the
installation screen:
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Installation

L3 warpii =
WarpiH  Archive Help

Welcome fo PMView Pro!

The following windows will guide youthrouah the installation of Phiew Pra.

Select " Mewt" o continue,
Select " Cancel" to ahort installation,

Cance|

2. Read the information and when you are ready to begin installing,
press the Next button. You will be asked to accept the license agree-
ment for PMView Pro. Once you have read the agreement, press |
Agreeto go to theinstallation directory selection:
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Installation for OS/2 Users

g wapn |

WwarplH  Archive Selections Help

Onthis page, you may deselect the package if it is already installed or change the package's target path,
Mote that the Drag & Drop Support package must be installed to a local drive.

ki

3 910 KE)
i PhViews ProDrag & Drop DLL Drive Information
v ¥ (w3000, 36KE)
Diive Free(KE} | PequiredikBd
C 2,311 % | [
4 4,087,227 4,910
E: 8,219,507 0
Total: 12,309,045 4,946
[d x|

Installed version: 3.0.0.22386
4 Back ” Hest & || Cancel

3. Enter the directory where you would liketo install PMView. The
WarplIN installer will select APPS\PMVIEW astheinstall directory
of the selected drive by default. You will need to use the WarpIN
menus to adjust the base path if needed. Once you have these set-
tings the way you want them, click the Next button to begin the
installation of the filesto your hard disk. Prior to the installation
progress indicator, you will be prompted to confirm the number of
packages that will be installed. A progress window will show you
the progress of theinstallation. If you installed a previous release of
PMView, you may be prompted to overwrite the PMVDDrop.DLL
file. It is recommended that you overwrite thefile if prompted.
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Installation

4. A window will appear that allows you to set the associations for
various image file types to PMView so that when you double-click
on afilein the Workplace Shell, it will be opened with PMView.

4 PHiView Pro - 5ef File Associations =

Select the file formats that you wizh to azzociate with PMYiew. Associating a format with
PhdWiew makes PhMYiew the default viewer for the format in question and you can launch
PhdWiew by double clicking on files of this farmat in the 0512 Workplace Shell.

1] Windows or 0512 Bitrap [BMF) ﬂ
[ Windows Cursor [CUR]

[ DCAlIntel [DCx)

[ CCITT Group 3 Facsimile [G3]

[l Flexible Image Tranzport Spstern [FIT, FITS]

[ Graphics Interchange Format [GIF]

[ “Windows or O5/2 lcon [ICO)

[ Electronic Arts [IFF, ILEM, LEM]

[ Digital Research GEM Paint [IMG)

[ JPEG File Interchange Format [JPG, JPEG. JIF, JFIF)
[¥] 0512 Boat Logo [LGO)

[ MacPaint [MALC]

[ Micrazoft Paint [MSP]

[ Kodak Photo CD [PCD)

[ &dobe Photoshop Document [FS0]

[l Z5oft Paintbrush [PCX] j
1 P PaintPictar Rin-Rad o Saftirmanes PICT

Deselect Al I

Rev. 3a

You can select and unselect file types by clicking them in thiswin-
dow. When you have the selections you want, click the Ok button.
A message window will advise you to reboot after the installation
completes to ensure that the file associations are updated:

4 PHView 2000 - Set File Associations I

The file associations have been set
6 successfully. A reboot may be

required for changes to become

effective. Press OK to continue.
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Installation for OS/2 Users

5. Once the installation compl etes, you will see afinal message
window:

&4 warpld =

-~ Installation has completed. Al changes made to your systern have been
w recorded inthe WwarpiM global database to be able to de - install this
application later, ‘workplace Shell objects have been created.

Click Ok to continue.

6. You will be returned to the main installation window at this
point. Click the OK button there to close the installation program.
We recommend that you reboot at this point and then you are ready
to use PMView Pro for OS/2.
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CHAPTER 3 Mmus

This chapter describes the menus of PMView Pro.

The File Menu

The File Menu is used to access the functions of PMView that deal
with such operations as opening and saving files as well as acquir-
ing images through screen capture and scanners.

New

This File Menu item allows you to create new files. Using this sub-
menu, you have the following options:

* |mage creates anew imagefile.

* Slideshow creates a new slideshow file.

* PMView Window opens a new PMView window, useful if you
want to compare two images onscreen at once.

Open

Use this File Menu item to bring up the File Open Window for
selecting afile to open. Both individual images and slideshow files
are opened in the File Open Window. The Ctrl + O hotkey sequence
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Menus

provides quick accessto this function. See the Windows chapter for
adiscussion of the File Open window.

Recall

For quick access to the files most recently opened, use this menu
item. It contains the last nine files you opened. You can reset the
list by choosing Clear List below thelist of files. Usethe Ctrl + R
hotkey sequence to access this function.

Next/Previous

Use this menu item to quickly cycle through the imagesin the cur-
rent directory. The options are

e First - view thefirst image in the directory.
* Previous - view the previous image.

* Next - view the next image.

e Last - view thelast image in the directory.

This menu item a so has two settings:

* Read Ahead - enables the preloading of files so that accessto
them is quicker.

e Wrap - Enables or disables wrapping. When enabled, PMView
will automatically wrap to the first image when you advance
beyond the last image with Next or wrap to the last image when
you advance beyond the first image with Previous. When dis-
abled, PMView will not do thiswrapping and stays at the last
(or first) image.

You will aso notice athird option herefor the File List. The
default option is Keep Refreshed. This option will refresh thefile
list when needed, but should be disabled if you have alarge number
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The File Menu

of filesin any one directory (1,000 or more), or if you notice the
Next/Previous action is slow. The second option to Refresh
performs the same function that is automatically performed by the
first option. The shortcut to refresh thefilelist is F5.

Save

This menu command savesthe current image. If theimage has been
previously saved, thiswill overwrite the old image. If it has not
been previously saved, the File Save Window will appear, allowing
you to specify the path and name of the file. Ctrl + Sisthe hotkey
sequence for this function.

Save As

Similar to the Save command, except that the File Save Window is
always displayed. Use this command when you want to save an
image to anew file (such as when converting from one image for-
mat to another).

Close

Removes the currently loaded image from PMView but PMView
itself remains open. The hotkey sequence for this function is Ctrl +

Q.

Info

This dialog shows you various statistics about the currently loaded
image.

¢ Filename The (long) name of thefile.

* Filesize The size of thefilein bytes (kilobytes)

* Image format The file'simage format.

* Imagesize The size of theimage in pixels
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Menus

* Number of colors The number of colors being used to display
the image.

* Resolution The resolution of theimage in pixels per inch (dpi).

Page number The number of the current page and the total number
of pagesinthefile.

Print

Displays the printing dialog window which allows you to set vari-
ous printing options and print the current image. See page 65 for a
discussion of the printing options that you can control with this
window. You can also display this window by using the Ctrl + P
hotkey sequence.

Copy/Moveto

Either of these options will bring up the File M ove dialog when
selected. This dialog lets you copy or move selected file(s). Note
that if more than onefileis selected you cannot alter the name of
the target file.

e Sourcedirectory This displays the directory from which files
will be copied or moved. (You cannot edit thisfield.)

e Target directory Thisletsyou typein or select the destination
directory to which files should be copied or moved. By default
thisis set to the most recently used directory. You can select
another directory in the list of most recently used directories by
clicking on its name. If the desired directory isnot in the list,
you can typeits name in the field.
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The File Menu

* Filename Thislets you change the name of the destination file.
Note that thisfield is only available when you copy or move a
singlefile.

e Iffileexists Thislets you select the type of action to take when

afile with the same name as the file copied or moved already
exists at the destination.

e Ask Thisoption will show the Confirm File Replace dialog.
The dialog will show you fileinformation and thumbnails of the
source and existing target file and let you decide what to do.

* Replace When using this option, an existing target file will be
replaced.

e Skip When using this option, no action will be taken if the tar-
get file exists.

* Rename When using this option, the target file will automati-
cally be renamed if atarget file with the same name already
exists.

Skip if identical If checked, the fileswill be bytewise compared
and if the filesareidentical no action is taken. If not checked, the
selected type of action is always taken.

Delete
This deletes the currently displayed image from disk.

Note: PMView will ask for file delete confirmation in accordance
with the setting on the Confirmations page in PMView's Options
Notebook.

The shortcut key for Delete is Ctrl+D.

War ning: This command isirreversible.
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Convert

This dialog lets you convert the selected file(s) to a different for-
mat. Note that if more than onefileis selected you cannot alter the
name of the target file.

e Script Thisletsyou select, create, edit or delete a conversion
script. Click New to open up the Script Editor and create a new
script. A conversion script is only needed for more complex
conversions. Use the predefined <None> option if all you want
isto convert the fileto a different format.

e Output format This lets you select the output format. The
Options button is enabled if the selected file format has format
specific settings.

e Output directory Thisletsyou typein or select the destination
directory where converted files should be placed. By default this
is set to the most recently used directory. You can select another
directory in the drop down list of most recently used directories.
If the desired directory isnot in thelist, you can typeitsnamein
the field. If the Use same directory as original setting is
checked, converted fileswill be placed in the same directory as
the sourcefiles.

* Filename Thislets you change the name of the destination file.
Note that thisfield is only available when you convert asingle
file.

e Iffileexists Thislets you select the type of action to take when
afile with the same name as the file copied or moved already
exists at the destination.
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The File Menu

e Ask Thisoption will show the Confirm File Replace dialog.
The dialog will show you fileinformation and thumbnails of the
source and existing target file and let you decide what to do.

* Replace When using this option, an existing target file will be
replaced.

* Skip When using this option, no action will be taken if the tar-
get file exists.

* Rename When using this option, the target file will automati-
cally be renamed if atarget file with the same name already
exists.

* Deéeteoriginal If checked, the source file will be deleted after
it has been converted.

Quick Script

This menu will list all scripts that have been marked as Quick
Scriptsin the Script Editor. The quick script will be processed in a
background task, so you can continue working with PMView while
thefileis processed.

Note: This function is also available on the file object menu in the
File Open Window. Running quick scriptsin the File Open Win-
dow hasthe added advantage that multiple files can be processed at
the sametime.

Set As Wallpaper

This menu contains various functions that let you set the currently
loaded image as your desktop background. The options are
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¢ Centered - centers the image on the desktop and keeps the size
of theimage.

e Tiled - tiles the image on the desktop by retaining its size but
piecing together multiple copies of theimage if it issmaller than
the desktop.

* Scaled - scalestheimage to fit the desktop by stretching it in
both directions if the image is smaller than the desktop.

None - removes any background image on the desktop. Note: The
image fileitself is not deleted.

TWAIN

* Acquire- If you have a TWAIN-compliant scanner, you can use
this menu item to scan an image directly into PMView.

* Select Source - Use this menu item to select the TWAIN-com-
pliant scanner to be used when scanning an image into
PMView.

The interface between an application and an image device's soft-
wareis handled by afile named TWAIN_32.DLL When you install
the software for an image device, acopy of TWAIN_32.DLL is
placed in the Windows directory. When PMView starts, it checks if
thefileisinstalled. If it is, the TWAIN-specific menu selections
Acquire and Select Source are made available. If it isn't, the menu
selections are grayed out.

It should aso be noted that if you have a TWAIN-compliant device
installed, but Acquire and Select Source on the File Menu are
grayed out, check to seeif TWAIN_32.DLL isinstalled in the Win-
dowsdirectory. If itisn't, try reinstalling your device software.
Make sure you turn on any options that pertain to TWAIN drivers.
If TWAIN_32.DLL isstill missing, contact the device manufac-
turer.
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The Edit Menu

Capture

PMView can capture images on your screen. The sub-menu pro-
vides the following capture functions:

e Window - captures an entire window, including the frame.

* Window Interior - captures the contents of awindow but not
the frame

e Screen - captures the entire screen.
e Areaof Screen - captures an area of the screen that you specify.

* Setup - lets you change various settings for capturing such as
the activation key and delay.

The Edit Menu

The Edit menu provides access to the system clipboard for cutting
and pasting operations, undo/redo operations and cropping.

Undo/Redo

Undo or redo the last change you made to the current image. Use
the Ctrl + Z hotkey sequence to access this function quickly from
the keyboard.

Free Undo Memory
Clears the undo/redo history.

Undo Enabled

Toggles the undo/redo function. When the menu item has a check
beside it, undo/redo is active.
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Cut

Removes the current selection and putsit on the clipboard. The hot-
key sequenceis Ctrl + X.

Copy

Copies the current selection and putsit on the clipboard. Use Ctrl +
C to access this function from the keyboard.

To mark a selection, hold down the left mouse button and move the
mouse to size the rectangle. Afterwards, if you would like to move
the selection rectangle you can point with the mouse somewhere
inside the selected area, hold down the left mouse button and move.
If you would like to resize the selection, you can grab any of the
eight handles and move the selected edge. The four handles at the
corners enables you to move two edges at the same time. The four
handles at the center of the edges |ets you move only the selected
edge.

If you need to make a very precise selection you can zoom into the
image with any of the Zoom functions.

Use the Selection Info window to view the coordinates and size of
the selected area.

You can cancel the selection by pressing Esc.

Paste

Pastes the image that is currently on the clipboard into PMView.
The paste can be done in two ways, accessible by the sub-menu:

¢ As Selection - pastes the clipboard contents onto the current
image as a selection that can be positioned beforeit isfinaly
pasted into the image. You can also use Ctrl + V to access this
function.
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The Transform Menu

¢ AsNew Image - clears the current image and pastes the con-
tents of the clipboard into PMView.

Crop

Trims the image by removing the pixels outside of the selected
area. The shortcut key isAlt + X.

Preserve Color Depth

Selects whether PMView should optimize colors for viewing or
preserve the full color depth for editing.

If not set, PMView will convert loaded images to look as good as
possible on your display. The image data may be converted, thus
you should not use this mode if you intend to save the image to
disk. For instance, loading a deep color image on a 256-color sys-
tem will reduce the number of colorsto 256 colors. If you save this
converted image, color information may be lost!

If set PMView does not convert loaded images. The full color
information of the original image will be retained. If your current
video mode is unable to display all color information in the image,
PMView will use dithering when showing the image. We recom-
mend that you always enable this option when saving files.

The Transform Menu

This menu item contains functions for performing various transfor-
mations on the image such as filtering (smoothing, sharpening,
etc.), rotation, and resizing.
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Mirror

The functions in this menu item allow you to reflect the image
about aline:

Horizontal - rotates theimage so that the horizontal positions of
pixels are flipped about the center of the image while the verti-
cal positions remain unaffected:

PMView warVM9

Vertical - rotates the image so that the vertical positions of the
pixels are flipped while the horizontal positions are unchanged:

PMView bBINATC/

JPEG Losdess Horizontal reverses (mirrors) left and right on
theimage.

JPEG L ossless Vertical reverses (flips) top and bottom on the
image.

Note that the JPEG L ossless functions are only available if the cur-
rently loaded image isin the JFIF file format. These functions oper-
ate directly on the file on disk and consequently do not need to
decode the JPEG data, resulting in alossless transformation. When
the transform is finished, the image is automatically reloaded from
disk and does not require further saving.
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Rotate
These functions rotate the image about a point at its center:

e 90° Clockwise - rotates the image 90° clockwise:

PMView

MIIAN

e 90° CounterClockWise - rotates the image 90° counter-clock-
wise:

PMView

PMView
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e 180° Upside Down - rotates the image through 180°:

PMView MIIANd

e Arbitrary Angle - rotates the image through an angle that you
specify:

A
PMView AfV

‘e Iy

The JPEG L ossless options alow you to rotate the image in the
same manner asthe JPEG L ossless Mirror options. Remember
that these options require that the currently loaded imageisin the
JFIF format and will not be available otherwise.

Size
Allows you to change the size of an image to one of several com-
mon sizes or to a specified size. In the dialog that appears, you will

not only be able to set the size of the image, but you will also be
able to choose from three options for the size action.
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First isthe L etter/Pillar box option. Thisis similar to adding a
border around the image. For instance, if you size an image of acir-
cle by 150% width and 110% height the circle will be increased in
size by 10% and it will still be around circle. The additional 40%
width increase will be established by pillarboxing (black bars are
added to the left and right of the imageto fill the new area).

The Keep Proportional option will reduce any distortion of the
image. If you uncheck this option and enlarge an image of acircle,
the circle will become an €ellipse.

The final option of Resample Pixels uses a pixel average method
to recalculate the pixels of the new image. Using resampling is
much slower, but gives afar better result. Note that the image will
be converted to RGB deep color when resampling is used. If not
checked, the pixelsin the new image will be generated by dropping
or duplicating image columns and rows.

Normal Filters

Applies various filters such as blurring, sharpening, and softening.

EdgeFilters

Appliesvariousfiltersthat |ocate and enhance edges (areas of sharp
contrast) in the image.

Special Filters

Provides access to the emboss and mosaic filters. The embossfilter
makes the image look like it israised out of ametal surface and the
mosaic filter gives the image a low-resolution blocky appearance.

User Defined Filters

Provides access to filters that you can define and modify. PMView
comes with avariety of specialized filters that you can use.
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The Color Menu

This menu allows you to modify various color settingsin an image.

Brightness/Contrast

Displays the Brightness/Contrast/Color dialog window where you
can change these values for the image.

RGB Balance

Displays a dialog window that can change the rel ative amounts of
red, green, and blue in an image.

Gamma Correction

The Gamma Correction dialog lets you adjust the gamma value for
an image when the image was produced on a device with a different
gamma. This function is used frequently with scanned images to
lighten or darken them so that they look better when displayed on a
monitor.

Solarize

The solarize function alters the colors of an image by inverting the
colors above or below a specified threshold.

Negative

Inverts the colors of an image.

Edit Palette

For images with 8-bit or smaller palettes, this menu item displays
the Palette editor (see page 68) which allows you to edit individual
colorsin animage.
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L oad Palette

Loads a previously saved palette. When the paletteis loaded, it is
applied to the currently opened image.

Save Palette
Saves the current palette.

Convert To

The sub-menus of this menu item provide functions to convert the
color depth of the image to another one:

¢ Black/White - converts the image to a 1-bit color depth (black
and white)

* Grayscale - converts the image to a 8-bit grayscale (up to 256
grays)

* Indexed 16-color - convertstheimageto a4-bit color depth (up
to 16 colors). See page 69 for more information.

* Indexed 256-color - converts the image to an 8-bit color depth
(up to 256 colors). See page 71 for more information.

* RGB Deep Color - converts the image to a 24-bit color depth
(upto 16,777,216 colors)

The View Menu

This menu contains functions that control how theimage isdis-
played, which parts of the PMView window are displayed, and a
dialog for setting program preferences.

Using PMView Pro 37



Menus

Page

For image files that contain more than one image, this menu item
provides the ability to view the different images:

e First - displaysthefirst image in the file

* Previous - displays the image located before the current one
* Next - displays the next image in the sequence

e Lagt - displaysthelast imagein thefile

* Goto - allowsyou to jump to a specified image in the file

Zoom

The Zoom functions allow you to zoom in or out on the image by
various percentages.

Full Screen

Scales the image to fit the screen and displays it without any win-
dow frames. Use the F3 hotkey to access this function from the key-
board.

Wrap Image

If the PMView window is larger or smaller than the current image,
this function will resize the window so that it fits the image. The F4
hotkey accesses this function aswell. Yet another way to access
this function is by double-clicking on the sizing grip in the right
hand corner of the PMView status bar.

Show

The Show menu has functions to control the appearance of the
PMView window as well as information on the image (size, num-
ber of pixels, etc.) and whether the selection info window should be
displayed when selecting part of the image.
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Title Bar - togglesthe visibility of thetitle bar on the PMView
main window

* Menu Bar - toggles the visibility of the main menu
* Tool Bar - toggles the visibility of the tool bar

e StatusBar - togglesthevisibility of the status bar at the bottom
of the PMView window

* Scroll Bars- togglesthe visibility of scrollbars if theimageis
larger than the PMView window

* Image Info - displaysthe Image Info window which shows
information on the image such as the file name, sizein pixels
and bytes, number of colors, and the image type.

e Selection Info - toggles the display of the Selection Info win-
dow when an area of the image is selected

Preferences

This command will open the PMView Options Notebook allowing
you to adjust various settings for the program.

The Help Menu

This menu provides access the various online help features of
PMView.

Help Contents
Displaysthe table of contents of the online PMView help.

KeysHelp

Shows the various hotkey sequencesthat can be used in PMView to
access functions from the keyboard.
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Using Help

Shows information on how to use the online help system.

Tip of the Day
This shows you the Tip of the Day dialog.

The Tip of the Day dialog box is normally displayed when you start
PMView, except when you are opening afile. You can change this
behavior so tips are never displayed or always displayed when
PMView is started. If you turn the Tip of the Day off and later want
to see the tips, choose "Tip of the Day" from PMView's "Help"
menu.

Web Resources

Clicking on one of these optionswill open your browser to the
specified online resource. Options include the PMView.com web-
site, online forums, online technical support and an online version
of the help file.

System Info

Displays awindow with various pieces of information about your
computer such as the CPU type, amount of memory, type of video

display, etc.

About PMView

Shows the product information window for PMView. Your
PMView licenseis displayed in thiswindow if you have purchased
PMView.
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CHAPTER 4 -I-he PM\AG’V
Windows

This chapter describes the various windows of PMView Pro.

The Main Window

When you start PMView, the main window is displayed:

# PMView Pro

File Edit Transform Color  View Help

=EH 0

WWHISTLERCdrivel arbwork),

The main window displaysimages and provides accessto al of the
program’s functions.

Using PMView Pro 41



The PMView Windows

The File Open Window

The File Open window is displayed when you choose the Open
item from the File menu or when you press the Ctrl + O hotkey
sequence. It has avariety of featuresthat make it easy to find and
open graphicsfiles.

#* File Open
(& Deskiop “/|| Open file name |*BMP:"CUR;* DCX:* EPS.* FITFITS: v |
= »_-} My Computer
g 3% Floppy (A2 List files of type |<AII Tupes» v|

“g Local Disk {C:)
i CO-RW Drive (D:
Z# developer on 'Sn
|3 Shared Documen
= \3 Iy Metwork Places
“ Entire: Metwork
L Elueprint Softwa
L £ on Hookyhoo
Ly Covive on Whistle
O Acrobats  —
() ADOBEARP
o
1) comp
() data ClearBlue.jpg Clematis.jpg Cockatiel. jpg
|3 Documents a
{C5) HyperCD
12 lexmark
I3 maredRT
{C3) Program Files
I vip
) tacls contemplating_... cupid_garden.jpg evening_comm...
I wacation
105) Windows Upe -
() WINNT v
+ inZij e
|la inze 3 . [ Open ] [ Cancel ] [ Help ]

-

Basdendo.jpg  bristol-shores.jpg

£
6.8 GE [ 12.7 GB (5.9 GE free) 24 files, 8.5 MB 15390050, TIF 640x430 24-bit TIFF 900.4 k

The lefthand side of the window shows the various folders on your
system and provides for easy browsing when searching for files.

The right-hand side contains the File Open Container (FOC). The
FOC shows thumbnail views of all theimage filesin the currently
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selected directory. By default PMView shows all valid image
types. If you want to display only a particular type of imagefile,
say JPEG images, then select the file type from the dropdown box
labeled “List Files of Type:.” To open afile, you can select it in the
FOC and then click the Open button, you can double-click the
thumbnail, or you can right-click on it and select Open from the
popup menu:

k Open in Current Window

Info... Open in Mew Window
Print... Open in Slideshow

Copy k...,
Move to...

Rename
Delete

Time Skamp  #
JPEG Rotate
Convert...

Convertka  F

The other functions available for the file popup menu are
¢ Info - displays information about the image such as size and
type

e Copy/Moveto - simple shortcuts that help you to get your files
organized.

* Rename- alowsyou to rename afile
¢ Delete - deletes the image file from your computer

e Timestamp - allows you to set the Creation Time and Last
Modified time of thefile

* JPEG LosslessRotate - gives severa optionsto quickly rotate
the image by 90 or 180 degrees. Only works with JPEG images

e Convert - displaysadiaog for converting the selected image to
another file format

e Convert to - displaysthe various formats available for immedi-
ate conversion
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e Quick Script - Thismenu will list all scripts that have been
marked as Quick Scriptsin the Script Editor

If you right-click on ablank part of the FOC (i.e. not on afile
thumbnail), you will seethe popup menu that controls the proper-
ties of the FOC:

Wigw 3
Refresh F5

Select: 3
Sart 3
Thumbnail Size 3

The View menu controls the appearance of the FOC:

Wigw Quick.
Refresh F5 Text

Select: (8 v Thumbnail
3

Sart
Mon-text

Thumbnail Size F v Grid
= HMongid
Multiple column
Single column
Detail

v Hidden Files
v Errar Marker

The various options are

* Quick - In quick mode, PMView does not scan the file for
information. Only the information returned by the operating
system isused. Thisisfast, but only filenames, sizes, dates, and
times can be loaded in this way.

e Text - displays filenames only

*  Thumbnail - displays thumbnails for each file.
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* Non-text - Images are shown as thumbnails without any text
(filename) displayed.

* Non-grid - Images are displayed with filenames under their
icons (or thumbnails). Images are "packed" as closely as their
file name texts alow. (File names are displayed in full).

* Grid - Images are displayed with filenames under their thumb-
nailsand are aligned in afixed grid pattern. Only thefirst line of
afile nameis displayed and if the file name is wider than the
thumbnail, it istruncated. The truncation is shown with an ellip-
sismark (...).

e Multiple column Files are displayed in alist layout with multi-
ple columns.

* Singlecolumn Filesare displayed in alist layout with only one
column.

e Detail - All available information is displayed for each image,
including file size, color depth, and date.

¢ Hidden Files- If set, PMView will show files that have the
Hidden system attribute set. If not set, PMView will not show
files that are hidden.

e Error Marker - If set, PMView will color the background of a
thumbnail red for potentially corrupt files. Potentially corrupt
files are files for which the decoding was not free from warn-
ings or errors. For instance only the last line or pixel (!) of the
image may be corrupt. Such a defect is hard or impossible to
notice just by looking at the thumbnail. The red background
helps you spot corrupt files more easily. Any file with ared
frame will aso cause an error message in PMView's status bar
when loaded.

The Refresh menu item in the FOC popup menu causes PMView to
refresh the list of image filesin the current directory. Thisis useful
when files are created with another program (like a scanning pro-
gram) while the File Open window is displayed. The F5 hotkey
also activates this function.
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The Select menuitem is used to select multiple images at atime:

Wiew 3
Befresh F5

m Selectall ik,
Sort ¥ Deselect all  Chl+M

Thumbnail Size ¥ Sticky Select

The sub-menu items are:

e Select All - selects all of the images currently displayed in the
FOC. Also accessible by the Ctrl + A hotkey sequence.

e Deselect All - cancelsthe current selection of files. The Ctrl + N
hotkey sequence also performs this function.

e  Sticky Selection - when set, left-clicking on imagesin the FOC
will cause the image to be added to the current selection set. If
you left-click a selected image, it will be deselected.

The Sort menu allows you to sort the imagesin the FOC by various
criteria

Wigw 3
Refresh F5
Select: 3
. . Extension
Irnage Format
Irmage Size:
Image Depth

Thumbnail Size 3

File: Size

Dake and Time

v Descending Crder
v Erroneous First

¢ Name - sorts by the name of thefile
* Extension - sorts by the extension of the filename
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* Image Format - sorts by the type of image, such as GIF, JPEG,
ete.

* Image Size - sorts by the pixel sizes of the images

* Image Depth - sorts by the color depths of the images

* File Size- sorts by the sizes of theimage files

* Dateand Time - sorts the images by their date and time

* Descending Order - toggles the direction of the sorting (e.g.
from largest to smallest to smallest to largest when sorting by
file size)

e Erroneousfirst - sorts the images based on any detectable
errorsfirst

The final menu item in the FOC settings popup is Thumbnail Size.
You can set the size (in pixels) to use when displaying thumbnails
of theimages.

Another popup menu is accessed by right-clicking on an area out-
side of the FOC, for example on the gray areato the right of the
Open/Cancel/Help buttons:

Fall Beginning....  halfmoonjpg  january_sunset...

s fies B ke ] \)
5 [ Open ] [ Eanee ] [ Help ] Float on top
v Hide window on Open
v on top of PrMyiew's main window v Show Status Bar

This popup menu controls the following settings:
* Float On Top - when selected, the File Open window always
remains on top of other windows.

¢ HideWindow on Open - when selected, the File Open window
will minimize when afileis opened.
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e Show SatusBar - toggles the display of the status area at the
bottom of the File Open window.

The File Save Window

The File Save window is used to save an image to afile on your
computer. It provides access to the directories on you disk drive as
well asthe variousfile types and settings:

# File Save

(& Deskiop | g ave file name |sunset-U1.bmp V|
(- My Computer

J4 3%Floppy || Saveastpe | BMP - 05/2 Bitmap v]
<o Local Disk (0
2L CO-RW Driy List files of type |<AII Types: v|
Z# developer ¢ I 3
I Shared Doc
(=% My Netwark Pla
“ Entire Metw
L Elueprint 5c
L £ on Hookyt
-k Covive on
I Acrobat
I ADCEE
) S
() comp halfmoon.jpg  january_sunset...
I data
| Docume
el — |
12 lexmark
Cmoee | | [N
{3 Progran ) )
@ tip lanuarny_sunset.. [anuary_sunset...
1) tools W
1) wacation 2

S Wi

Aiada Save
evening_comm... Fall_Beginning.... Options

Cancel

Help

|

I

6.8 GE [ 12.7 GB (5.9 GE free) 24 files, 8.5 MB 15390050, TIF £40:x480 24-bit TIFF 900.4 kB 4/11,

Like the File Open window, the lefthand side of the File Save win-
dow showsthe disk drive(s) on your computer and operates like the
Windows Explorer.
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On the right-hand side at the top you can set the following:

¢ Save File Name - the name of the file when the image is saved.

* Save AsType- thefileformat of the saved image such as GIF
or JPEG.

e List Filesof Type - showsfiles of the specified type in the con-
tainer below.

When you have set the file name and type, you can set any type-
specific options by clicking the Options button. The Options win-
dow that appears will have a different appearance depending on the
file type. The Options window for the GIF format, for example,
looks like this:

GIF Save Options

Always write GIF89a format
[ interace
[ Transparent color indsx [0..255)

[ Background color index [0..255)

[ QK ] [ Cancel ] [ Drefault ] [ Help ]

And the JPEG Options window looks like this:

JPEG Save Options g|
Cluality
J 78
a 50 100
Smoathing
J a
a 50 100

Optimize entropy encoding
[ Progressive JPEG
Save EXIF information

[ QK ] [ Cancel ] [ Drefault ] [ Help ]
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Clicking on the Help button will give you information on the vari-
ous settings for agiven file type. Once you are satisfied with the
settings, click the Ok button. The Cancel button will close the
Options window without making any changes. The Default button
will set the options to default values.

Once you have the various settings the way you want them, click on
the Save button in the File Save window to save thefileto disk. If
you wish to cancel without saving anything, click the Cancel but-
ton.

The Sideshow Window

If you drag multiple files from the File Open window to the main
PMView window, PMView creates a slideshow and shows the files
sequentially. The main window takes on an appearance similar to
the File Open Container (FOC) discussed on page 42.

If you right-click on an empty part of the Slideshow Container
(SSC), you will see a popup menu almost identical to the popup
menu of the FOC except for the addition of the Scramble and Run
All menu items:

File 3
Wiew 3
Help 3
Wiew Slides 3
Befresh F5
Select 3
Sort 3
Scramble

Fiun all Ale+R
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Scramble, as you might guess, scrambles the order of thefilesin
the SSC. Run All starts the slideshow. Alt + R will also start the

slideshow.

If you right-click on an image in the SSC, you will see this popup

menu:

e Settings - displays the slideshow settings for that image:

Open 3

Settings. ..

Copy Settings  »
Remave

Run

Here you can set the advance to the next image to be manual or

15390050.TIF - Settings ®

Advance to nest image
O Manually
() Automatically after

5 % seconds

[ -

Motes
Dizplay notes

Sunset while on vacation in... |

[ QK ] [Eancel] [ Help ]

to automatic after the specified time. On the right, you can type
notes to be displayed when the image is displayed in the slide-

show.

* Copy Settings - copies the settings from the current image to

the selected images:
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Settings. .. I

Copy Settings ¥ All Settings

Remove v Selected Settings
Run

.+ ManualfAutomatic
Qpen ¥ v Advance Time

Mote Text

All Settings copies al of the settings.
Selected Settings copies only the settings that are checked.

¢ Remove - removes the file from the slideshow.
* Run - starts the slideshow with the selected image(s).

*  Open - alows you to open the selected image(s) in a new
PMView window

Creating a slideshow opens the Slideshow Controller window:

Slideshow Controller

L Jlm Jln J[» ]

Fev Stop FPause Flay

The buttons of this window behave like the buttons on aVCR:

* Rev - playsthe dlideshow in reverse order.

e Sop - stopsthe slideshow if it is playing.

* Pause - pauses the slideshow at the current image.
* Play - playsthe slideshow in forward order.

The slider bar shows the current image position in the slideshow
and can be manipulated with the mouse to set the current positionin
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the dideshow. Asfilesareloading, the progress bar above the slider
bar will indicate the status of the file's loading.

The Preferences Notebook Window

The Preferences Notebook window controls the many settings for
PMView:

# PMView Preferences g@f@

Slideshow | Shidesettings | Special/TwAIM | Confirmations | Shortcut keys
Yiew | ‘window | Loading | Directory | Extensions | Display | Photo CD

Momal screen view

Center image if it iz smaller than window
[ Z0om image ta fit window

[]Z00m image if it is larger than window

[1Z00m image if it is smaller than window

Full screen view

Center image if it iz zmaller than screen
Zoom image if it iz larger than screen
Zoom image if it iz smaller than screen
Hide mouse pointer

[ Ok ] [ Eancel] [Default]

The View page of the Preferences Notebook controlsthe following
settings.

For normal (windowed) screen view:

* Center imageif it issmaller than window
When set, PMView draws the imagein the center of the window
if the window is larger than the image. Otherwise, theimageis
drawn in the upper left corner.
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Zoom imageto fit window

When set, the image is zoomed proportionally to fit the size of
the PMView window, so that the larger of the horizontal or ver-
tical dimension of the image matches that of the window.

Zoom imageif it islarger than window Enabling this setting
will make PMView automatically zoom out (shrink) an image

that istoo large to fit the window. Thissetting isalso accessible
in the Zoom menu under the name Automatic Zoom Out to Fit.

Zoom imageif it issmaller than window Enabling this setting
will make PMView automatically zoom in (enlarge) an image
that istoo small to fit the window. If the Window Size options
on the Window page in PMView's Options Notebook are set to
alow window resizing, the window will be enlarged to fit the
desktop. This setting is also accessible in the Zoom menu under
the name Automatic Zoom In to Fit.

For full screen view:

Center imageif it issmaller than screen

If theimage is smaller than the screen, PMView will center it on
the screen. When this setting is unchecked, PMView draws the
image in the upper |eft corner of the screen.

Zoom imageif it islarger than screen

If the image islarger than the screen, PMView will zoom out so
that the image will fit on the screen. As aways with zoomingin
PMView, it is done proportionally so that there is not distortion
in the image.

Zoom imageif it issmaller than screen

If theimage is smaller than the screen, PMView will expand the
image proportionally so that its larger side fits the screen.

Hide mouse pointer

Hides the mouse pointer when you enter full screen mode. Note
that the “Zoom image if it is larger than screen” and “Zoom
image if it is smaller than screen” settings may interfere with
this one. If you disable one of these settings, or both, you will
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get scrollbars depending on the size of the loaded image. If this
is the case, and you have a scrollbar visible, the mouse pointer
will not be hidden.

The Window page of the Preferences Notebook has the following
settings.

# PMView Preferences g@f@

Slideshow || Shidesettings | Special/TwAIM | Confirmations | Shortcut keys
View | Window | |oading | Directory | Extensions | Display | Photo CD

Window size
Fiesize window when loading a new image

Resize window when editing or zooming

Window position

Move window when required w

[] &llows moving window on top of system taskbar

[ &llows maving left and top borders off screen

[ QK ] [Eancel] [Default] [ Help ]

For the window size:

* Resize window when loading a new image
This setting causes PM View to automatically resize the window
when loading a new image so that it matches the size of the
image.

*  When editing or zooming
If you are editing or zooming an image, PMView will automati-
cally resize the window as appropriate. For example, if you
rotate a rectangular image by 90°, the window will resize to fit
the new dimensions.

For the window position:
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* Never move window
Disables any automatic movement of the PMView window,
meaning that the upper left corner of the window always
remainsin the same place.

* Movewindow when required
Allows PMView to change the position of the window if doing
so will enable you to see more of the image.

* Always center window on screen
The PMView window will always be centered on the screen
when it is positioned (e.g. by pressing F4).

* Always move window to upper left corner
This option will move the window to the upper Ieft corner of the
screen every time the window is positioned.

* Always move window to upper right corner
This option will move the window to the upper right corner of
the screen every time the window is positioned.

* Always move window to lower left corner
This option will move the window to the upper Ieft corner of the
screen every time the window is positioned.

e Always move window to lower right corner
This option will move the window to the lower right corner of
the screen every time the window is positioned.

¢ Allow moving window on top of system taskbar
Enables the PMView window to cover the taskbar.

* Allow moving left and top borders off screen
If set, PMView isfree to move itstop and | eft window borders
outside the visible area of the screen. If not set, PMView will
keep al borders within the screen limits.

The Loading page of the Preferences Notebook deals with
PMView’s actions when |oading images.
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5 PMView Preferences g@@|

Slideshow | Shidesettings | Special/TwAIM | Confirmations | Shortcut keys
iew | Window | Loading | Directory | Extensions | Display | Photo CD

Startup options
() Startup minimized (iconized)
(&) Momal

() Full screen each lnaded image automatically

Loading options
Progreszive loading
Enable animation
[ Beep on emor

Deleting or moving current image loads nest image

[ QK ] [ Eancel] [Default] Help

For the startup options:

Startup minimized (iconized)

Causes PMView to start up minimized.

Normal

PMView starts with the size of the image that was last |oaded
or, if you specify an image on the command line, starts it with
the size of the specified image.

Full screen each loaded image automatically
PMView goesinto full screen mode for each loaded image.

For the loading options:

Progressive loading

With this setting PMView will clear any current image and
show the new image progressively asit loads. For large format
Photo-CD images (1536x1024 and above), however, the pro-
gressive display will not occur immediately since the first half
of the image must be read before any display can be done.
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Enable animation If set, PMView will load animated files (e.g.
GlFfiles) and display theimage frames (pages) according to the
scheme stored in thefile. If not set, PMView will only load the
first frame of thefile.

Beep on error
If an error is encountered when reading afile, PMView will
beep and display a message in the status bar.

Deleting current image loads next image

If set, PMView will automatically load the next image when the
currently viewed image is deleted. Note that the Ctrl + Del
shortcut key performs the same function. Thus, you may want to
use Ctrl + Del instead of enabling this option.

The Directory page of the Preferences Notebook deal swith settings
involving default directories for PMView.

5 PMView Preferences E@g|

Slideshow | Shdesettings | Special/TwAIM | Confirmations | Shortcut keys
View | Window | Loading | Directorny | Ewtensions | Display | Photo CD

Configure directories
Drefault File Open directory

Default File Save directary

Automatically change File Open directory
Automatically change File Save directory

[ Ok ] [ Eancel] [Default]

Default file open directory

Set thisto the directory that you would like the File Open win-
dow to start at. If you leave this blank, the most recently used
directory will be the defaullt.
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e Default file save directory
If you would like the File Save window to open to a particular
directory, specify it here. If left blank, the File Save window
will open to the most recently used directory.

e Automatically change File Open directory and selection
If set, PMView will automatically change the directory in the
File Open window to the directory of the currently loaded file.
The selection (cursor) will be moved to the loaded fileif itis
present in the File Open container. If not set, PMView will use
the most recently used directory, or the Default File Open direc-
tory.

* Automatically change File Save directory and selection
If set, PMView will automatically change the directory in the
File Save window to the directory of the currently loaded file.
The selection (cursor) will be moved to the loaded fileif itis
present in the File Open container. If not set, PMView will use
the most recently used directory, or the Default File Save direc-
tory when specified.

The Extensions page of the Preferences Notebook allows you to set
the file extensions and descriptions of file formats.
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# PMView Preferences EJE] g|

Slideshow | Shidesettings | Special/TwAIM | Confirmations | Shortcut keys
iew | Window | Loading | Directory | Extensions | Display | Photo CD

Configure file extensions
Extenzion

*BMP

Description

EP - 05/2 Bitmap

“EPS
“FITAFITS
“G3
“GIF
*ICO v

[ Ok ] [ Eancel] [Default]

You can add new file extensions as well as edit or delete existing
ones.

The Palette page of the Preferences Notebook is only active if you
are running your display in 8-bit (256 color) mode.

MY¥iew Preferences =] B3

Fhoto CD I Slideshow I Slidesettings I Special/ Tl I Confirmations | Shortcut keys I

Wiew I window I Loading I Directory I Extenzions Dizplay

r— Palette management option
¥ Blank window before changing the palette

I~ Override system colars in full screen mode

— Color rendering option:

Falette type Dither type
* Adaptive = Mone

= Spstem ¢ Ordered
884 levels &+ Diffusion
= B-7E levels

= BEE levels

QK I Eancell Defaultl Help |
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¢ Blank window before changing the palette
Because successive images may require different palettes, set-
ting this option causes PMView to blank the window before
loading a new image to avoid problems with color noise. If you
have a slideshow with images that all use the same palette, you
will probably want to turn this option off to avoid unnecessary
blanking.

* Override system colorsin Full Screen mode
The operating system usually reserves 20 colorsfor itself. If you
set this option, PMView will use all 256 colorsin full screen
mode.

Consult the online help for adetailed description of the Color Ren-
dering settings depending on your display type.

The Display page of the Preferences Notebook has settings that can
have significant impact on PMView's performance.

5 PMView Preferences E@g|

Slideshow | Shidesettings | Special/TwAIM | Confirmations | Shortcut keys
iew | Window | Loading | Directory | Extensions | Display | Photo CD

Diizplay options
[ Use resampling when scaling

[ Adjust dizplay gamma

Use smooth keyboard scrolling
Speed [pelés) | 2500 % Latency [ms) | 20 %
Accelerate to speed

[ Ok ] [ Eancel] [Default]

e Useinterpolation when scaling
When zooming, PMView can merely replicate the pixels or it
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can resample them. Replication isfaster but will probably result
in ablocky appearance. Resampling results in much smoother
images at the expense of speed since many cal culations must be
made.

* Adjust gamma
Enable this control if you need to adjust the gamma factor used
when PMView draws the image to the screen. Enabling this
option will make the painting to screen slower. Whether thisis
noticeable or not depends on your hardware. Note that you need
to restart PMView before changes to this setting become effec-
tive.

The Photo CD page of the Preferences Notebook controls the reso-
lution of Photo CD images when they are |oaded.

5 PMView Preferences g@@|

Slideshow | Shidesettings | Special/TwAIM | Confirmations | Shortcut keys
Wiew | Window | Loading | Ditectory | Extensions | Display | Photo CD

Fhoto CO' options
Default resalution
192 w128 (O 163E=1024
(384w 256 (O 30725 2043
@78 x 512 (O E144 » 4096

Ask. for resolution before loading image

[ QK ] [Eancel] [Default] [ Help ]

Select the default resolution that you want. If you want to select the
resolution when an image is loaded, check the “ Ask for resolution
before loading” box.
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The Slideshow page of the Preferences Notebook is used to config-
ure the behavior of PMView in slideshow mode.

#*= PMView Preferences = @@
i *window | Loading | Directory || Extensions | Display | Photo CD
Slideshow | Slidesettings || Special/ TwaIN || Confimations | Shortout keys

Slideshow options
Run full screen
[] Run continuously
[ Run scrambled
[] Swap mouse buttons
[] &utostart
0K__| [Cancel] [Default ]

The following options can be set:

Run Full Screen
Slides will be displayed in full screen mode when this optionis
checked. If not checked, slides will be shown in the PMView
window according to the settings on the Window page of the
Preferences Notebook. See page 55 for those options.

Run Continuously
When set, the slideshow will loop around to the beginning when
the last slide is shown. Otherwise, the slideshow ends after the
last slide.

Run Scrambled
This setting randomly rearranges the order of the dides beforeit
is played. Once the slideshow isfinished, the original order of
the slides is restored, leaving the slideshow unmodified.

Swap M ouse Buttons

Reverses the function of the mouse buttons so that the left
mouse button advances the slideshow by one frame while the
right button goes back one frame.
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e Autostart
Causes a slideshow to start automatically when loaded.

The Slidesettings page of the Preferences Notebook is used to set
the default settings for new dlideshows. Existing slideshows are
unaffected by this page.

# PMView Preferences EJE] g|

Wiew || Window | Loading || Directory | Extensions || Display | Photo CD
Slideshow | Shidesettings | Special/T'wialN | Confirmations | Shortcut keys

Drefault Slide Settings
Advance to nest image

O Manually
() Automatically after 5 % seconds

[] Display nates

MOTE: These settings are not applied to exizting
zlidezhowsz. They only determine the default zettings
for new slideshows. Prezz Help for more information.

[ QK ] [Eancel] [Default] [ Help ]

e Advanceto Next Image
You can set the advance to be done manually or automatically
after a specified amount of time.

e Display Notes
When set, the notes for each frame will be displayed in a small
window with the slide image.

The Special/TWAIN page of the Preferences Notebook controls
some special color options and TWAIN scanning options.
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5 PMView Preferences E@g|

Wiew window Loading Directory Extenzions Dizplay Fhoto CD
Slideshow Slidesettings Special/ TWAIN Confirmations Shortcut keys

Special options

[ Count the number of colors for deep color images
Uze idle time priority

[ Do not mave files to the Recycle Bin

[] Dynamically change the Phyiew program icon
TwiaIM options

[] Use buffered memary transfer mecharizm

Float on top

Cloze uzer interface after scanning

[ Ok ] [ Eancel] [Default]

Under Special Optionsis“Count the number of colors for deep
color images.” When thisoption is set, PMView will calculate the
number of distinct color huesin aloaded image. The color count is
recal culated whenever you update an image in away that changes
its color information (e.g. resizing with interpolation). Note that
enabling this option makes PMView somewhat slower. How
noticeabl e the slowdown is depends greatly on the way you use
PMView. If you load images one at atime and you have a reason-
ably fast CPU, you can use this option without noticing a differ-
ence. If, on the other hand, you prefer to start a dozen simultaneous
PMView sessions from the OS shell, the slowdown may be signifi-
cant (up to 30%) and thus you may opt not to use this option.

Other special optionsinclude:

e Useidletimepriority If set, PMView will use below-normal
priority when it loads thumbnails and when you run batch con-
versions. Generally this gives smoother overall performance
since PMView will easily give up CPU time to other programs
that need it. However, this could potentially be a problem if you
are running "CPU hogging" programs that require lots of CPU
power to run. (Potential CPU hogging programs are for instance
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DOS programs and older games). In this case PMView may
seem to get "stuck” or processfiles very slowly sinceit isgiving
away al its CPU time to the hogs. If thisisthe case, you may
want to disable idle-time loading. Otherwise, we recommend
that you leaveit on.

Note: This option is off by default if PMView isinstalled on the
Windows 95/98/ME family of operating systems. It ison by
default in the Windows NT/2000/XP family of operating sys-
tems.

Do not move filesto the Recycle Bin If set, PMView will
remove files from your disk as soon as you delete them. If not
set, the items you delete are moved to the Recycle Bin.

Under TWAIN Options you can control these settings for scanning:

Use Buffered Memory Transfer

If set, PMView will use the more efficient TWSX_MEMORY
transfer method that transfers the image in chunksin buffered
memory. If not set, PMView will use the TWSX_NATIVE
transfer method that transfer the complete image viaadevice
independent bitmap (DIB). We recommend you not to disable
this option unless you have a problem with the image transfer
from TWAIN to PMView.

Float On Top

If set, the TWAIN dialog will always stay on top of PMView's
main window. Note that it is up to the TWAIN driver if it
respects this setting or not. The setting only specifies what par-
ent window handle PMView passes on to the TWAIN driver.
Consequently some TWAIN drivers will never stay on top of
PMView's window even if this option is enabled. Other drivers
may do the opposite and always stay on top. Thisisnot abug, it
isjust depends on how your TWAIN vendor decided to imple-
ment their driver.

Close User Interface After Scanning
If set, the TWAIN dialog will be closed when scanning is com-
plete. If not set, the dialog will be left open. Note that it isup to
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the TWAIN driver if it respects this setting or not. Some
TWAIN drivers may require that the interface is closed after
scanning and will close the interface regardless of this setting.
Other drivers may do the opposite and always keep the interface
displayed until the user explicitly dismissesit.

The Confirmations page of the Preferences Notebook controls how
PMView prompts you in various situations.

5 PMView Preferences g@@|

Wiew || Window | Loading || Directory | Extensions || Display | Photo CD
Slideshow | Slidesettings | Special/T'wialN | Confirmations | Shartcut keys

Confirmations

Canfirm on file delete

Ask whether to save changed images
Ask whether to zave changed slideshows
Ask whether to continue converting files

File copy/maove confirmations
Azk what to do if file exists v

[ Skip if files are identical

[ Ok ] [ Eancel] [Default]

Confirm On File Delete

If set, PMView will always ask you to confirm the deletion of a
file. If not set, PMView will delete files without asking for con-
firmation.

Ask Whether To Save Changed | mages

If set, PMView will ask you whether you would like to save
changed images before exiting or not. If not set, PMView will
discard your changes to an image without asking when exiting.
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e Ask Whether To Save Changed Slideshows
If set, PMView will ask you whether you would like to save
slideshows before exiting or not. If not set, PMView will discard
unsaved dlideshows without asking when exiting.

e Ask Whether To Continue Converting Files
If set, PMView will prompt you to abort the conversion of files.
If not set, PMView will stop the conversion of files without ask-

ing when quitting PMView or closing the file open or file save
window.

File Copy/M ove confirmations

Here you can adjust how PMView notifies you of existing files and
the actions to take when copying or moving files into the same
location.

Thefinal page of the Preferences Notebook, Shortcut Keys, allows
you to set hotkey combinations for various functions.

# PMView Preferences g@f@

Wiew || Window | Loading || Directory | Extensions || Display | Photo CD
Slideshow | Slidesettings | Special/T'walN | Confirmations | Shortcut keys

Configure shortcut keys

Category Current keys
File w | | ChileM
Command

Mew->Image
Mew-»Slideshow

Mew->Phiew Window
Open
Recal
Recall->Clear List
Pl 1Dt i ¥
Prezz new shortcut key
Load 1.0 layout
[ QK ] [ Eancel] [Default] [ Help ]
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e Category
Use this to select the subgroup of the command for which you
would like to modify the shortcut key. All the main menu
options are listed here. Note that in addition to the menu options
it isalso possible to configure slideshow and scrolling keys.

e Command
Thislets you select the command for which you would like to
modify the shortcut key.

e PressNew Shortcut Key
Thisfield lets you enter the shortcut key. First press  any mod-
ifiers you want (a combination of Ctrl, Alt, and Shift), if any.
Then press the key.

e Current Keys
Lists the current key assignments for the command currently
selected in the Command list. Note that the first key listed isthe
one that is shown in the menus.

* Assign Key
Adds the key definition in the Press new shortcut key field to
thelist of shortcut keys. The new key isaways added last in the
list. If you wish to rearrange the keysin order to get a specific
key first (so that it is displayed in the menus) you need to first
remove any preceding keys and add them again.

* RemoveKey
Removes the key that is currently selected in the Current keys
list. If no key is selected, this button is disabled.

e Load v1.0 Layout
Pressing this key loads the PM View version 1.0 keyboard lay-
out. (Use the Default button to load the PMView Pro default

layout).
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The Print Window

The Print window allows you to set various properties for printing
an image:

Image size (inches]

v
Width | Height

Marging [inches) _

Left | 025 3| Right | 028 3
Top | 025 4| Bottom 025 %

Printable area; 7.97 % 1050 inches
Center image between marging

Page onentation
O Automatic (&) Porrait O Landscape

Range and copies

MNurnber of copies 1 B

Printer | Brather HL-1240 v

Gamma | 1.00 &

Unitz  |inches v

(Piirt_| [Cancel] [ Help | [ Setup... |

Image Size

Use the Width or Height control to set the desired size of the image.
Note that PMView is ableto split the image on severa pagesif the
selected size istoo large to fit on one sheet of paper. This allows
you to create alarge poster by gluing the pages together.

Pressing the Fit Pixels button will adjust the print size so that one
picture element (pixel) on the printer corresponds to one pixel of
image data. Note that this may result in incorrect image size if the
resolution of the image is not the same as the resolution of the
printer. (For instance, if you scanned the image with 150 dpi and
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print it on @300 dpi printer, the printed image will be only half the
height and width of the original scanned image).

Pressing the Fit Resolution button will adjust the print size so that a
previously scanned image will get the same size when printed as
the original was. Note that this requires that a correct resolution fig-
ureisavailable for the image.

Pressing the Fit Page button will adjust the print size so that it fills
the printable area of the page. (Note that the margins affect the size
of the printable area).

Margins

Use the Left, Right, Top, and Bottom controlsto set the desired
margins. Note that it is possible to drag the margins in the preview
window.

Printable areatells the maximum printable size. (The space
between the left and right margin, and the top and bottom margin
respectively).

Use Center image between margins to select whether the image
should be centered or not. Note that the image is not centered on
the page. It is centered between the margins. Consequently, if you
want the image centered on the page, you need to make sure that
the left and right margins are the same and that the top and bottom
margins are the same.

Page orientation

The Page orientation controls lets you set the paper orientation.
When Automatic is selected, PMView will automatically select the
orientation according to the image dimensions. If the image width
exceeds its height, landscape will be selected and vice versa.

Other options
Printer lets you select which printer you want to use.

The Unit selector lets you set the desired unit of measurement; pix-
els, millimeters, or inches.
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The Gamma control lets you adjust the printer gamma. You may
need thisif your image printout istoo bright or dark. Values below
one (1) makesthe image darker, values above one makesit brighter.

Use the Page control to select which page should be displayed in
the preview window. Note that this control is only visibleif the
desired print size requires multiple pages.

Press Print to print thefile.

Press Setup... to bring up the Job Propertiesdialog. Thisletsyou set
paper size and other printer specific options.

Note: If you wish to print several subsequent images with aspecific
size you may consider adjusting the margins to the size you want
and then use the Fit Page option. For example if you want your
images 4" wide and 2" tall, then adjust the margins so that the Print-
able areaindicator reads "4.00 x 2.00 inches". Then press Fit Page.

The Palette Editor

Thiswindow lets you edit each palette slot in the pal ette associated
with the current image. Deep color images don't have a pal ette and
the Edit Palette option on the main menu is thus disabled. In this
case you can use the Convert option to convert the image to 256
colors or fewer.
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Edit Palette 53
Falette: Fed Green - Blue
TPy
EEEEEENEEENEEEEn
AEEEEEEEEEN " EEEN
ENEEEEE B EEETEN
BN . |
AN EEEEEEEN T EEN
ENEEEEEEEEEEE
ENEE EE H EEEEE
EENEENE EEEEEE =

| 1| HEN EEE =
ETEEE B H EE
] | EEE'E B |
| HE EEE
ENEEEEN HETE B
HEN HEN EOEN
EEEENENE H EEEE oo

Indew: 0 HTHL color: 090803 nd

[ QK ][Eancel][ Help ] lII

Select the color you would like to edit by clicking on the desired
color dot. The slots are ordered from Ieft to right, top to bottom
with the first slot at the top |eft corner. The palette slots are
arranged in order of frequency. Thefirst dot contain the color that
has the highest frequency (is most used) in theimage. The last dlot
(bottom right) has the lowest frequency.

If the image has fewer than 256 colors the empty palette slots are
disabled (indicated by adiagonal line pattern). These empty slots
cannot be edited.

The Convert to 16 Colors Window

This window opens when you select “Indexed 16-color” from the
“Convert To” sub-menu of the Color menu:
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Convert to Indexed 16-color g]

Falette type Diither type
() Adaptive O Mone
) System

(O 222 levels () Diffusion

[ QK ] [Eancel] [ Help ]

The settings are
Palette

Adaptive Thiswill select the 16 best colors for the image. The pal-
ette generated for the image is optimized and unique for thisimage.

System Thiswill only use the 16 fixed colorsin the system palette.
The palette for the image is fixed. Images converted to system pal-
ette will all have the same palette.

2-2-2 levels Thiswill use a standard 2-2-2 level palette, that is, a
palette with 2 intensity levels for each color component
(Red,Green,Blue), thus the image will be reduced to a maximum of
8 colors.

Dither

None The colors will be selected on best match basis. The color
error is not compensated.

Ordered Ordered dithering is used to compensate the error.
Ordered dithering can only be used with the 2-2-2 level palette.

Diffusion Floyd-Steinberg error diffusion dithering is used to com-
pensate the color error.
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The Convert to 256 Colors Window

This window opens when you select “Indexed 256-color” from the
“Convert To” sub-menu of the Color menu:

Convert to Indexed 256-color g]

Falette type Diither type
() Adaptive O Mone
) System

O 884 levels () Diffusion

(O B-76 levels Mumber of colars
O 666 levels 286 # | calors

*

[ QK ] [Eancel] [ Help ]

The settings are
Palette

Adaptive Thiswill select the 256 best colors for theimage. The
palette generated for the image is optimized and unique for this
image.

System Thiswill usethe 256 fixed colorsin the system palette. The
palette for the image is fixed. Images converted to system palette
will al have the same palette.

8-8-4 levels Thiswill use the vaunted 3-3-2 bits fixed pal ette, that
is, apalette with 8 intensity levels for the Red and Green compo-
nents and 4 levels for Blue. This palette was used in the 2.x ver-
sions of Microsoft Windows.

6-7-6 levels Thiswill use a 6-7-6 level fixed palette, that is, a pal-
ette with 6 intensity levels for the Red and Blue component and 7
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levels for Green, thus the image will be reduced to a maximum of
252 colors.

6-6-6 levels Thiswill use a 6-6-6 level fixed palette, that is, a pal-
ette with 6 intensity levels for each color component
(Red,Green,Blue), thus the image will be reduced to a maximum of
216 colors. This palette is well suited for systems with palette man-
ager since the Palette Manager works best if the pal ette contains no
more than 236 color entries.

Dither

None The colors will be selected on best match basis. The color
error is not compensated.

Ordered Ordered dithering is used to compensate the error.
Ordered dithering can only be used with R-G-B level palettes.

Diffusion Floyd-Steinberg error diffusion dithering is used to com-
pensate the color error.

Number of colors

If you have selected Adaptive Pal ette this will let you select the
maximum number of distinct colorsin the image.
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All code for handling the file formats supported in PMView has
been written completely from scratch. Therefore, we are proud to
be ableto provide full technical support on all of the formats below
and enhance support for a specific format when needed (for
instance, the TIFF format). If PMView failsto load afile that you
need, please contact us so we can try to support your file'sformat in
our next release.

OS2 Bitmap (BMP)

General Description

The bitmap format wasintroduced in the early 1.1 version of OS/2.
Later, Microsoft Corp. enhanced the format and included it inits
best selling operating environment: Microsoft Windows 3.0. In OSY/
2 2.0 IBM further extended the format by adding some fields and
by defining a structure for storing multiple bitmaps in the samefile
(thistype of fileis often referred to as abitmap array). Although we
have put much effort into making PMView savefileswith all the
possible bitmap compression schemes, we discourage you from
using them since many applications cannot deal with compressed
0S/2 bitmaps.
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BMP isthe default extension for bitmap files under OS/2.

Supporting Platformsand Applications

Intel machines running OS/2.

PMView Support
PMView will read all types of OS/2 and Windows bitmaps.

The following bitmap types, bitcounts and compressions are sup-

ported:
Type Bitcount Compressions
IBMOS/21x 1,2,4,8,24
bitmaps
IBMOS/21x 1,2,4,8,24
bitmap arrays
IBMOSR22x 1,2,4,8,24 HUFFMAN_1D, RLE_4,
bitmaps RLE_8,RLE_24
IBMOS/22x 1,2,4,8,24 HUFFMAN_1D, RLE 4,
bitmap arrays RLE_ 8, RLE_24
Windows3.x  1,2,4,8,24 RLE 4,RLE 8
bitmaps

* HUFFMAN_1D: Modified Huffman 1D encoding. Applicable

only to black & white images.

* RLE_4: Run length encoding. Applicable to images with 4 bits

per pixel (16 colors or fewer)

¢ RLE_8: Run length encoding, 8 bits per pixel (256 colors or

fewer)

* RLE_24: Run length encoding, 24 bits per pixel (deep color

images)
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Windows Bitmap (BMP)

General Description

The bitmap format wasintroduced in the early 1.1 version of OS/2.
Later, Microsoft Corp. enhanced the format and included it in its
best selling operating environment: Microsoft Windows 3.0. In OSY/
2 2.0 1BM further extended the format by adding some fields and
by defining a structure for storing multiple bitmapsin the samefile
(thistype of fileis often referred to as abitmap array). Although we
have put much effort into making PMView save fileswith al the
possible bitmap compression schemes, we discourage you from
using then since many applications cannot deal with compressed
Windows bitmaps.

The extension RLE is sometimes used for run length encoded bit-
map files under Windows. Another common extension under Win-
dowsisDIB. BMP isthe default extension for bitmap files.

Supporting Platformsand Applications

Intel machines running Microsoft Windows, MS-DOS, Windows
NT.

PMView Support
PMView will read all types of OS/2 and Windows bitmaps.

The following bitmap types, bitcounts and compressions are sup-
ported:

Using PMView Pro 79



File Formats

Type

IBM OS/21.x
bitmaps

IBM OS/21.x
bitmap arrays
IBM OS/22.x
bitmaps

IBM OS/22.x
bitmap arrays

Windows 3.x
bitmaps

Bitcount
1,2,4,8, 24

1,2,4,8,24

1,2,4,8 24

1,2,4,8, 24

1,2,4,8 24

Compressions

HUFFMAN_1D, RLE 4,
RLE 8, RLE 24

HUFFMAN_1D, RLE 4,
RLE 8, RLE 24

RLE 4,RLE 8

* HUFFMAN_1D: Modified Huffman 1D encoding. Applicable

only to black & white images.

* RLE_4: Run length encoding. Applicable to images with 4 bits

per pixel (16 colors or fewer)

¢ RLE_8: Run length encoding, 8 bits per pixel (256 colors or

fewer)

e RLE_24: Run length encoding, 24 bits per pixel (deep color

images)

Windows Cursor (CUR)

General Description

The CUR format is the native cursor (pointer) format under Win-
dows. Note that the Windows cursor format is significantly differ-
ent from OS/2's pointer format. Thusit is very important that you
choose the right format when you save cursors.
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The default extension is CUR.

Supporting Platformsand Applications

Intel machines running Microsoft Windows, MS-DOS, Windows
NT.

PMView Support
PMView will read all types of Windows cursors.

DCA/Intel DCX Format (DCX)

General Description

Digital Communications Associates (DCA) and Intel have
designed the DCA/Intel Communicating Applications Specifica-
tion (CAS). It defines a standard, high-level programming interface
for data communications applications. The DCX format is the stan-
dard file format for storing FAX imagesin CAS.

The default extension is DCX.

Supporting Platformsand Applications

Intel based PCs running applications supporting the DCA/Intel
Communicating Applications Specification (CAS).

PMView Support

PMView supports DCX in compliance with the DCA/Intel Com-
municating A pplications Specification Version 1.2.
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Technical Information

DCX files are a series of one or more PCX files. However, since
DCX isdesigned to store FAX data only, the following restrictions
apply to DCX files:

* Theimage must be black and white. Shades of gray or color are
not allowed.
e Thewidth of an image must not be greater than 1,728 pixels

¢ The recommended maximum height of an image is 2,200 pixels

Encapsulated Postscript (EPS)

General Description
The Encapsul ated PostScript format is a general -purpose format for
storing text and graphicsin vector or raster form.

The default extension for Encapsul ated PostScript filesis EPS

Supporting Platforms and Applications

Thisformat is supported by numerous applications on awide range
of platforms.

PMView Support

PMView can only write EPSfiles, it cannot read them. Note that by
using a program called GhostView (freely available on Internet)
you can view EPS files and convert them to PBMPlusfiles (PBM,
PPM, etc.) that are readable by PMView.

82 Using PMView Pro



Flexible Image Transport System (FITS)

Flexible Image Transport System
(FITS

General Description

The FITS format is a general-purpose data storage format used pri-
marily for the interchange of data between hardware platforms and
software applications. FITS is the standard image data storage for-
mat for many astronomical organizations, including the astrophys-
ics branch of NASA.

The default extension for FITSfilesisFIT.

Supporting Platformsand Applications

Thisformat is supported by numerous applications on awide range
of platforms.

PMView Support

PMView reads FITS files that contain an image with a BITPIX
value of 8, 16, 32, -32, or -64. The value of NAXIS must betwo (2)
or greater.

CCITT Group 3 Facsimile (G3)

General Description

The CCITT Group 3 Facsimileis adatafile containing Group 3
FAX datain "raw" form (i.e. no header).
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The default extension for CCITT Group 3 filesis G3

Supporting Platformsand Applications

Thisformat is used by numerous FAX applications on awide range
of platforms.

PMView Support

The FAX datais assumed to have a data row width of max 1728
pixels and a height of minimum 10 pixels.

Graphics Interchange Format (GIF)

General Description

The GIF format was designed by Compuservein 1987. Sincethen it
has become very popular for general image exchange. There are
two types of GIF files;, GIF87a, the original standard of 1987 and
GIF89a, the revised standard of 1989 that adds features for includ-
ing comments, animation and text.

The GIF format isalossless format and is good for saving any type
of image that has 256 colors (or shades of gray), or fewer.

Thisformat is suitable as a generalized format for image exchange,
though the color information limit in the format may require you to
choose PNG, TIFF or JPEG instead. In general thisisthe best for-
mat for images with alimited number of colors, since the compres-
sionratio is good (regarding that the format islossless) and GIF
files can be decompressed very quickly.

The default extension for GIF filesis GIF
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Supporting Platformsand Applications

Thisformat is supported by numerous applications on awide range
of platforms. However, please note that due to legal restrictions
recent applications may not support the GIF format. (The LZW
compression used in GIF is patented by Unisys and software mak-
ers may decide not to provide GIF support in their application.)

PMView Support

PMView supportsthe original GIF87a specificationin full. GIF89a
files can a so be read, but GIF89a specific information will be
ignored.

Versions; 87a, 89a
Bitcount: 1..8

The GIF compression/decompression included in this softwareis
licensed under U.S. Patent No. 4,558,302 and foreign counterparts.

The Graphics Interchange Format(c) is the copyright property of
CompusServe Incorporated. GIF(sm) is a service mark property of
CompuServe Incorporated.

OS2 Icon (ICO)

General Description

The ICO format is the native icon format under OS/2 and Win-
dows. Note that the Windows icon format is significantly different
from OS/2'sicon format. Thusit is very important that you choose
the right format when you save icons.

The default extension is |CO.
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Supporting Platformsand Applications

Intel machines running OS/2

PMView Support

PMView isableto read all types of OS/2 icons; The old "Icon" and
the new "Color Icon" format can be read.

Windows Icon (ICO)

General Description

ThelCO format isthe nativeicon format under OS/2 and Windows.
Note that the Windows icon format is significantly different from
0OS/2'sicon format. Thusit is very important that you choose the
right format when you save icons.

The default extension is |CO.

Supporting Platformsand Applications

Intel machines running Windows

PMView Support
PMView will read all types of Windows icons.
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Electronic Arts IFF (IFF)

General Description

The |FF format was defined by Electronic Arts back in 1985. The
IFF format is quick and easy to read and uncompress. However, it
lacks a good compression scheme, making it unsuitable for storage
of deep color images. Note that the IFF format can be used to hold
awide variety of information. An IFF file does not necessarily con-
tain an image; it can contain sound clips, animations, text or what-
ever else,

The default extension is IFF, though you are likely to encounter a
lot of other extensions like MP, HAM, ILBM, LBM, etc.

Supporting Platformsand Applications

This format is commonly used on Commodore Amiga computers.
However, it is supported by numerous applications on awide range
of platforms.

PMView Support

PMView only supports FORM type | FF files that holds an image.
The following two sub-types are supported:

e [LBM: 1..n planes
e PBM: 8 bits chunky format

The following special types of ILBM files are supported:

¢ HAM: 3..16 planes

¢ Dynamic HAM (DHAM)
 Sliced HAM (SHAM)

e Palette change (PCHG)
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PMView uses information from the following chunks (if available)
when reading an | FF file:

e BMHD

e CAMG

* CMAP

e SHAM

e CTBL

* PCHG

e BODY

Digital Research GEM (IMG)

General Description

The GEM format is used by applications such as Ventura Publisher,
GEM Draw, GEM Scan, and GEM Paint. On the Atari ST where
GEM isthe standard operating environment, most graphical appli-
cations support this format.

The default extension for GEM filesisIMG

Supporting Platformsand Applications
GEM, MS-DOS, Atari ST.

PMView Support

PMView supports both new and old type GEM files. Old type files
supported are either 1 bit/pixel black & white, 2..4 bit/pixel color
(EGA color map), or 8 hit grayscale. New type files can be 1..8 hit/
pixel grayscale or 24-bit color. Note that 24-bit color images
require Ventura4.0. If you're going to import the image into an ear-
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lier version of Ventura you must convert the image to black &
white or grayscale before saving it.

JPEG File Interchange Format (JPG)

General Description

The JPEG format isa"lossy" format, meaning that the image you
get out of decompression isn't quiteidentical to what you originally
put in. The algorithm achieves much of its compression by exploit-
ing known limitations of the human eye, notably the fact that small
color details aren't perceived as well as small details of light-and-
dark. Thus, JPEG isintended for storing images that will be looked
at by humans. If you plan to machine-analyze your images, the
small errorsintroduced by JPEG may be a problem for you, even
though they are invisible to the eye. Thisformat is excellent for
general image exchange.

The extension recommended by the Joint Photographic Experts
Group is JF. Another commonly used extension is JPG, which is
the default.

Supporting Platformsand Applications

Thisformat is supported by numerous applications on awide range
of platforms.

PMView Support

Support in accordance with the Independent JPEG Group's revision
6a.

The JPEG codec included in this software is based in part on the
work of the Independent JPEG Group.
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OS2 Boot Logo (LGO)

General Description

The OS/2 Boot Logo format is used under OS2 Warp versions 3
and 4 for storing the boot logo. The boot logo isthe image that is
shown at first when OS/2 starts up after are-boot.

Under Warp 3, the size of the boot logo image is 640x400 pixels.
The VGA resolution used at boot time is 640x480. Warp 3 reserves
80 lines at the bottom of the screen for showing copyright informa-
tion. This space cannot be used and thus the size of the boot logo
must be 640x400. (Using a 640x480 boot logo under Warp 3 will
result inan OS2 TRAP at system startup.) Warp 4 does not reserve
this space and a full-screen 640x480 boot logo may be used under
Warp 4.

The boot logo fileislocated on the root of the OS/2 boot drive. The
name of thefileis OS2L OGO and by default the file has the system
attributes hidden, system, and read-only set.

The default extension is LGO.

Supporting Platforms and Applications

Intel machines running OS/2 version 3.x and above

PMView Support

PMView support the boot logo format of Warp 3.x and Warp 4.x.
When saving files in the OS/2 Boot Logo format, PM View will
automatically resize the image to the correct size; 640x400 or
640x480 depending on the selected format).Interpolation is used
when resizing and the aspect ratio is maintained. The colorswill be
reduced to the set of 16 fixed colors of the EGA palette.
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MacPaint (MAC)

General Description

MacPaint isthe native format for MacPaint, a drawing program for
the Apple Macl ntosh.

The default extensionis MAC.

Supporting Platformsand Applications

Maclntosh. This format is supported by many applications on vari-
ous formats. However, the format is monochrome only and require
the image to be of fixed size.

PMView Support

PMView supports MacPaint versions 0 and 2. However, PMView
does not use the version number when checking if the fileisaMac-
Paint file or not, so aslong as the image datain the MacPaint fileis
the same asin versions 0 and 2, the image can be read. When sav-
ing filesin the MacPaint format, PMView will automatically resize
the image to the correct size (576x720). Interpolation is used when
resizing and the aspect ratio is maintained.

Note that PMView separately reads and handles the information in
aMacBinary header, if available. The MacBinary header is not part
of the MacPaint format and PMView will not write MacBinary
headers when saving files. (A MacBinary header is a structure that
allows Maclntosh programs and data to be transferred outside the
Maclntosh environment and back.)

Technical Information

MacPaint is a monochrome, black & white format that uses pack-
bits
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encoding. The size of MacPaint images is fixed: 576 x 720 pixels.

Microsoft Paint (MSP)

General Description

MSP is the native format for Windows Paint, a drawing program
found in the early 1.0 and 2.0 versions of Microsoft Windows. In
Windows 3.0 this program was replaced by Windows Paintbrush
which writes Windows Bitmaps (BMP) by default, thus rendering
M SP obsolete.

The default extension is MSP.

Supporting Platformsand Applications

MS-DOS, Microsoft Paint. The format is a simple monochrome
format that was in wider use in the early days of Microsoft Win-
dows. Today the MSP format is obsolete.

PMView Support
PMView supports MSP versions 1 and 2.

Technical Information

MSP is a monochrome, black/white format that uses a variant of
run-length encoding.
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Kodak Photo CD (PCD)

General Description

Kodak Photo-CD alows you to have conventional photographs
converted to Kodak's proprietary CD-ROM format. Not all CD-
ROM drives can access Photo-CDs. You might want to contact
Kodak for afull list of those that can. Each PCD file contains five
scans of the same image at the resolutions listed bel ow. Photo-CD
filesreside in the \PHOTO_CD\IMAGES\ directory on the CD-
ROM and are named IM Gxxxx.PCD, where xxxx is a four digit
number ranging from 0001 to the number of images on the disk.

A sixth resolution (6144x4096) may be available on Photo-CD
PRO disks. Thisisan extension to the standard, and residesin adif-
ferent directory on the disk. PMView will use the information in
\PHOTO_CD\IPE\IM Gxxxx\64BASE\INFO.IC when reading this
resolution.

PMView Support

All five standard image resolutions and orientations are supported.
When needed, theimages will automatically be rotated without any
extramemory overhead during decoding. The Photo-CD PRO
extension (64 Base) is also supported.

PMView will prompt you for the desired resolution before loading
an image. A default resolution can also be specified in the options
notebook.

Thumbnails will be loaded from \PHOTO_CD\OVERVIEW.PCD
if itisavailable. An option for automatically loading/showing the
startup file \PHOTO_CD\STARTUP.PCD is not available. How-

ever, if required, it can be viewed simply by changing the directory.
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Technical Information

Standard Photo CD image resolutions and memory needed for
decoding:

Resolution Memory Needed
192 x 128 73,728 bytes
384 x 256 294,912 bytes
768 x 512 1,179,648 byte
1536 x 1024 4,784,128 bytes
3072x 2048 19,070,976 bytes
6144 x 4096 75,694,080 bytes

The specified amount of memory needed for decoding includes the
size needed for the huffman tables and may therefore differ from
the size reported by other programs.

ZSoft Paintbrush Format (PCX)

General Description

PCX files are created by ZSoft's PC Paintbrush, one of the most
popular PC drawing tools.

The default extension is PCX.
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Supporting Platformsand Applications

Thisformat is supported by numerous applications on awide range
of platforms.

PMView Support
The following PCX revisions are supported:

e Version 2.5 of PC Paintbrush

e Version 2.8 with or w/o palette

e Version 3.0

¢ Version 5.0 including 24-bit PCX

PMView is not dependent of the version number tag, so in practice
PMView should be able to display any PCX file conforming to the
technical specs below. The version list aboveis provided as a
guideline only.

Technical Information
Images up to 8-hit color depth [bits* planes <= g]:

1, 2, 4 or 8 bits
1, 2 or 4 planes

Support for 24-bit images (PCX rev 5.0):

3 planes
8 hits

PCX files created for an EGA screen may lack a color map. When
reading such files PMView will use a default EGA palette. (If the
image shows up astotally black in another application, one possible
problem is that the image does not have a color map and the appli-
cation is not able to provide a default color map.)
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PC Paint/Pictor (PIC)

General Description

PIC filesare created by PC Paint/Pictor (not PC Paintbrush) and are
used by Grasp, among others.

The default extension is PIC. Note! Thisextensionisused by a
number of applications to mean widely different things. If PMView
cannot read your file with PIC extension, you can assume that it
isn't a PC Paint/Pictor file. For instance, PMView will not read
Lotus 1-2-3 PIC files (these are vector graphics, not bitmaps).

Supporting Platforms and Applications
MS-DOS. PC Paint/Pictor, Grasp, and many others.

PMView Support

In conformance with the PIC file specifications PMView will be
ableto display any PIC file complying to the plane- and bitcounts
below.

1..8 planes, 1..8 hits per pixel (2..256 colors)
3 planes, 8 bits per pixel (16M colors)

Currently PMView does not support the following new modes,
however they will be supported in alater version of PMView:

1 plane, 16 bits per pixel (65k colors)
1 plane, 24 bits per pixel (16M colors)

PIC files created for an EGA screen may lack a color map. When
reading such files PMView will use a default EGA palette. (If the
image shows up astotally black in another application, one possible
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problem is that the image does not have a color map and the appli-
cation is not able to provide adefault color map.)

Bio-Rad PIC (PIC)

General Description
The Bio-Rad file format is used by software from Bio-Rad Micro-
science Ltd.

The default extension for Bio-Rad filesis PIC.

PMView Support

This version of PMView only reads grayscale Bio-Rad PIC files
that have eight bits per pixel.

Softimage Picture (PIC)

General Description

The Softimage picture file format (Pl C) was designed by Softimage
Co. for use with itsline of 3-D animation software. A Softimage
PICfileis capable of storing true color data and alphachannel for a
frame of an animation. (Note that this format is not capable of hold-
ing a complete animation, it is only intended to hold one single
frame of an animation).

The default extension is PIC.
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PMView Support

This version of PMView reads and writes standard Softimage pic-
ture fileswith eight bits per channel.

PBMPIus Portable Bitmap (PBM)

General Description

PBMPlusfiles are created by Jef Poskanzer's PBMPlus Portable
Bitmap Utilities. PBMPlus uses three different file types. These are
the Portable Bitmap (PBM), Portable Graymap (PGM), and Porta-
ble Pixmap (PPM) formats. PBM can store monochrome (black &
white) bitmaps only. PGM additionally stores grayscale bitmaps,
and PPM can store color bitmaps. There is also afourth format;
Portable Anymap (PNM). PNM is not a different file format in
itself, but afile of type PNM can hold any of the three PBMPlusfile
types listed above.

The default extension is PBM.

Supporting Platformsand Applications
PBMPlus files are common under UNIX and on Intel-based PCs.

PMView Support

In conformance with Jef Poskanzer's specifications of 1990. The
full specification isincluded bel ow.

Technical Information

The portable bitmap format is alowest common denominator
monochrome file format. It was originally designed to make it rea-
sonable to mail bitmaps between different types of machines using
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the typical stupid network mailers we have today. Now it serves as
the common language of alarge family of bitmap conversion fil-
ters. The definition is asfollows:

A "magic number" for identifying the file type. A pbm file's
magic humber is the two characters"P1".

Whitespace (blanks, TABS, CRs, LFs).

A width, formatted as ASCII charactersin decimal.
Whitespace.

A height, againin ASCII decimal.

Whitespace.

Width * height bits, each either '1' or ‘0, starting at the top-left
corner of the bitmap, proceeding in normal English reading
order.

The character '1' means black, '0' means white.
Whitespace in the bits section isignored.

Characters from a"#" to the next end-of-line are ignored (com-
ments).

No line should be longer than 70 characters.

Hereis an example of asmall bitmap in this format:

P1

# feep.pbm

247
000000000000000000000000
011110011110011110011110
010000010000010000010010
011100011100011100011110
010000010000010000010000
010000011110011110010000
000000000000000000000000
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Programs that read this format should be as lenient as possible,
accepting anything that looks remotely like a bitmap.

Thereisalso avariant on the format, available by saving the image
with the RAWBITS option. Thisvariant isdifferent in thefollowing
ways.

e The"magic number" is"P4" instead of "P1".

* The bits are stored eight per byte, high bit first low bit last.

* Nowhitespaceis allowed in the bits section, and only asingle

character of whitespace (typically anewline) isallowed after the
height.

¢ Thefiles are eight times smaller and many times faster to read
and write.

PBMPIlus Portable Graymap (PGM)

General Description

PBMPlusfiles are created by Jef Poskanzer's PBMPlus Portable
Bitmap Utilities. PBMPlus uses three different file types. These are
the Portable Bitmap (PBM), Portable Graymap (PGM), and Porta-
ble Pixmap (PPM) formats. PBM can store monochrome (black &
white) bitmaps only. PGM additionally stores grayscale bitmaps,
and PPM can store color bitmaps. There is also afourth format;
Portable Anymap (PNM). PNM is not a different file format in
itself, but afile of type PNM can hold any of thethree PBMPlusfile
types listed above.

The default extension is PGM.

Supporting Platformsand Applications
PBMPlus files are common under UNIX and on Intel-based PCs.
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PMView Support

In conformance with Jef Poskanzer's specifications of 1990. The
full specification isincluded bel ow.

Technical Information

The portable graymap format is alowest common denominator
grayscale file format. The definition isasfollows:

A "magic number" for identifying the file type. A pgm file's
magic humber is the two characters "P2".

Whitespace (blanks, TABSs, CRs, LFs).

A width, formatted as ASCII charactersin decimal.
Whitespace.

A height, againin ASCII decimal.

Whitespace.

The maximum gray value, again in ASCII decimal.
Whitespace.

Width * height gray values, each in ASCII decimal, between O
and the specified maximum value, separated by whitespace,
starting at the top- left corner of the graymap, proceeding in
normal English reading order. A value of 0 means black, and the
maximum value means white.

Characters from a"#" to the next end-of-line are ignored (com-
ments).

No line should be longer than 70 characters.

Hereis an example of asmall graymap in this format:

P2

# feep.pgm
247

15
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0000O00O0O0OOO0O0OOOO

70011111111 0015151515 0
00011000001500150

000111111 000151515150
0001100000150000
70011111111 0 015
000000O0OO0OO

0

© o

00
00
Programs that read this format should be as lenient as possible,

accepting anything that looks remotely like a graymap.

Thereisaso avariant on the format, available by saving the image

with the RAWBITS option. Thisvariant isdifferent in thefollowing

ways.

¢ The"magic number" is"P5" instead of "P2".

* Thegray values are stored as plain bytes, instead of ASCI| deci-
mal.

* Nowhitespace is allowed in the grays section, and only asingle
character of whitespace (typically anewline) isallowed after the
maxval.

* Thefiles are smaller and many times faster to read and write.

Note that this raw format can only be used for maxvals smaller than
or equal to 255.

PBMPIus Portable Pixmap (PPM)

General Description

PBMPlusfiles are created by Jef Poskanzer's PBMPlus Portable
Bitmap Utilities. PBMPlus uses three different file types. These are
the Portable Bitmap (PBM), Portable Graymap (PGM), and Porta-
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ble Pixmap (PPM) formats. PBM can store monochrome (black &
white) bitmaps only. PGM additionally stores grayscale bitmaps,
and PPM can store color bitmaps. There is also afourth format;
Portable Anymap (PNM). PNM is not a different file format in
itself, but afile of type PNM can hold any of the three PBMPlus
file typeslisted above.

The default extension is PPM.

Supporting Platformsand Applications
PBMPlus files are common under UNIX and on Intel-based PCs.

PMView Support

In conformance with Jef Poskanzer's specifications of 1990. The
full specification isincluded bel ow.

Technical Information

The portable pixmap format is alowest common denominator color

image file format. The definition is asfollows:

* A "magic number" for identifying the file type. A ppm file's
magic humber is the two characters "P3".

¢ Whitespace (blanks, TABs, CRs, LFs).

* A width, formatted as ASCII charactersin decimal.

e Whitespace.

* A height, againin ASCII decimal.

e Whitespace.

¢ Themaximum color-component value, again in ASCII decimal.

e Whitespace.

e Width * height pixels, each three ASCI| decimal values
between 0 and the specified maximum value, starting at the top-

Using PMView Pro 103



File Formats

left corner of the pixmap, proceeding in normal English reading
order. The three values for each pixel represent red, green, and
blue, respectively; avalue of 0 means that color is off, and the
maximum value means that color is maxed out.

* Charactersfrom a"#" to the next end-of-line are ignored (com-
ments).

* Noline should be longer than 70 characters.

Hereis an example of asmall pixmap in this format:

P3

# feep.ppm

44

15

000 000 00O 15015
000 0157 000 00O
000 000 0157 00O
15015 000 000 0OOO

Programs that read this format should be as lenient as possible,
accepting anything that looks remotely like a pixmap.

Thereisalso avariant on the format, available by saving the image
with the RAWBITS option. Thisvariant isdifferent in thefollowing

ways:

e The"magic number" is"P6" instead of "P3".

* Thepixel values are stored as plain bytes, instead of ASCII dec-
imal.

* Whitespace is not allowed in the pixels area, and only asingle

character of whitespace (typically anewline) isallowed after the
maxval.

* Thefiles are smaller and many times faster to read and write.
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Note that thisraw format can only be used for maxvals smaller than
or equal to 255.

PBMPLus Portable Anymap (PNM)

General Description

PBMPlusfiles are created by Jef Poskanzer's PBMPlus Portable
Bitmap Utilities. PBMPlus uses three different file types. These are
the Portable Bitmap (PBM), Portable Graymap (PGM), and Porta-
ble Pixmap (PPM) formats. PBM can store monochrome (black &
white) bitmaps only. PGM additionally stores grayscale bitmaps,
and PPM can store color bitmaps. There is also afourth format;
Portable Anymap (PNM). PNM is not a different file format in
itself, but afile of type PNM can hold any of the three PBMPlus
file types listed above.

The default extension is PNM.

Supporting Platformsand Applications
PBMPlus files are common under UNIX and on Intel-based PCs.

PMView Support

In conformance with Jef Poskanzer's specifications of 1990. The
full specification isincluded bel ow.

Technical Information
A PNM file can hold one of the three PBMPlus formats bel ow.

¢ Portable Bitmap (PBM)
* Portable Graymap (PGM)
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* Portable Pixmap (PPM)

Portable Network Graphics (PNG)

General Description

The PNG format isintended to provide a portable, legally unen-
cumbered, well-compressed, well-specified standard for lossless
bitmapped image files.

PNG is highly recommended as a generalized format for image
exchange.

The default extension is PNG.

Supporting Platformsand Applications

Thisformat is supported by numerous applications on awide range
of platforms.

PMView Support

PMView supports the PNG format in full, according to PNG Speci-
fication Version 0.96 (11 Mar, 1996). We have coded al the rou-
tines from scratch and optimized the code for speed under OS/2,
thus PMView does not use the public PNG-library.

Color Type and Bit Depth
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Bit Depth Interpretation
0 1,248,116 Grayscale images
2 8,16 RGB deep color images
3 1248 Colormapped images
4 8,16 RGB deep color images with alpha chan-
nel
6 8,16 Grayscal e images with apha channel
Compression Type

0 Deflate/inflate compression with 32K gliding window

Filter Type
0 Adaptivefiltering with five basic filter types

Interlace Type
0 Nointerlace

1 Adam? interlace

Adobe Photoshop Document (PSD)

General Description
The PSD format is the native file format of Adobe Photoshop.
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The default extension is PSD.

Supporting Platformsand Applications

Adobe Photoshop and numerous applications on the Windows and
Maclntosh platforms.

PMView Support

Supported bit countsare 1, 8, and 16. If the bit count is 1, theimage
is assumed to be monochrome (Color mode = 0).

Compression Type
0 No compression

1 MacIntosh PackBits encoding

Color modes

Monochrome
Grayscale
Indexed color
RGB color
CMYK color
Multichannel
Duotone

© 0 N b WO N P O

L*a*b* color
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OS2 Pointer (PTR)

General Description

The PTR format is the native pointer format under OS/2. Note that
the Windows cursor format is significantly different from OS/2's
pointer format. Thusit is very important that you choose the right
format when you save pointers.

The default extension is PTR.

Supporting Platformsand Applications

Intel machines running OS/2

PMView Support

PMView isableto read all types of OS/2 pointers; The old
"Pointer" and the new "Color Pointer" format can be read.

un Raster (RAS)

General Description

The Sun Raster format is the native bitmap format on the Sun
UNIX platforms. It isasimple bitmap format with wide distribu-
tion, particularly in the UNIX world.

The default extension for Sun Raster filesisRAS

Supporting Platformsand Applications
Sun OS and many UNIX based applications.

Using PMView Pro 109



File Formats

PMView Support

PMView can read Sun Raster fileswith 1..32 bits. Supported file
types are Old (00h), Standard (01h), Byte-encoded (RLE) (02h),
and RGB format (03h).

Compuserve RLE (RLE)

General Description
The Run Length Encoded (RLE) graphicsfile format isasimple
ASCII based monochrome format that is used on Compuserve.

The default extension for Compuserve RLE filesis RLE.

Supporting Platformsand Applications

Run Length Encoded graphics files are used on Compuserve.

PMView Support

PMView supports Medium (128x96) and High (256x192) resolu-
tion RLE files.

Utah RLE (RLE)

General Description

The Utah RLE format was developed by Spencer Thomas at the
University of Utah Department of Computer Science. Thefirst ver-
sion appeared around 1983. The Utah RLE format was devel oped
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mainly to support the Utah Raster Toolkit, which iswidely distrib-
uted in source form on the Internet.

The default extension for Utah RLE filesis RLE.

Supporting Platformsand Applications

Utah Raster Toolkit and many other graphics utilities, mainly under
UNIX.

PMView Support
PMView supports the following types of Utah RLE files:

* GRAY SCALE 8 hits, no colormap

e MAPPEDGRAY 8 hits, 1 channel colormap
* PSEUDOCOLOR 8 hits, 3 channel colormap
¢ TRUECOLOR 24 bits, 3 channel colormap
e DIRECTCOLOR 24 bits, no colormap

Sructured Fax Format (SFF)

General Description

The Structured Fax File format is the normative file format for stor-
ing Group 3 fax documents in an environment based on the COM-
MON-ISDN-API (CAPI) standard.

Supporting Platforms and Applications

Thisformat is mainly used for transfer of fax documentsin
Microsoft Windows applications.
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PMView Support

PMView will read and write SFF files in accordance with the
COMMON-ISDN-API (CAPI) version 2.0 specification (4th edi-
tion).

Seattle Film Works (SFW)

General Description

The Seattle FilmWorks file format is used for images created by
Seattle FilmWorks Inc., afilm processing company located in Seat-
tle, WA.

The default extension for Seattle FilmWorks files is SFW.

Supporting Platformsand Applications

Seattle FilmWorks' PhotoWorks software on Microsoft Windows
and Apple MacIntosh platforms.

PMView Support

PMView reads Seattle FilmWorks files using modified JPEG data
(SFW944). The older undocumented SFW93aformat is not sup-
ported.
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Gl Image File (SGI)

General Description

The SGI image file format is part of the SGI image library found on
al Silicon Graphics machines. SGI image files may store black &
white (.BW extension), color RGB (.RGB extension), or color
RGB with alpha channel ((RGBA extension) images. SGI image
files may have the generic extension.SGI as well.

The default extension for SGI Image filesis SGI.

Supporting Platformsand Applications
SGI graphics software.

PMView Support
PMView supports the following types of SGI files:

Method of Storage  Verbatim (00h), RLE (01h)
Bytes per color lor?2

channel

Number of 1 or 3 (any number of planes>=11is
planes accepted

Color maptype  Normal (00h), Dithered (01h), or Screen

(02h)
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PMView Sideshow File (SHW)

General Description
Thisisthe format of PMView slideshows.

The default extension is SHW.

Supporting Platforms and Applications
Thisformat is native to PMView.

PMView Support

PMView will read files that have been generated by PMView
(saved by PMView) or files that have been edited with a standard
ASCI|I editor.

Technical Information

A PMView slideshow file consists of afile header and one or more
image headers.

File Header

PMView SlideShow
BeginShow

[Image Header(s)]

iEndShow

Image Header
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Beginimage
[Image Statement(s)]

Endimage

Image Statements

FileName Full filename + path

UseTimer [YesINO]

Display- Time to display (in seconds)

Time
Showlnfo [Yes|No]
Information  Notes text

Example of a slideshow file:

PMView SlideShow

BeginShow

Beginlmage

FileName D:\ssiimagel.jif
Showinfo  Yes
Information 'Demo slideshow
Endimage

Beginlmage

FileName  D:\ssiimage2.jif
UseTimer  Yes
DisplayTime 2
Endimage

Beginlmage

FileName  D:\ssiimage3,jif
UseTimer  Yes
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Endimage
EndShow

In this example the note "Demo slideshow" will be displayed with
the first image (imagel.jif). Thetimer is not used for the first
image, the user must manually continue. The second image
(image2.jif) uses the timer and will display for 2 seconds. The third
image also uses the timer and will display the default time; 5 sec-
onds.

Truevision Targa File (TGA)

General Description

In addition to developing the famous Truevision Targa boards,
Truevision Inc. also have come up with a specification for a high-
end file format that will support images suitable for display on
Targahardware. The Targaformat, or TGA, supportsimages of any
dimensions with between 1 and 32 bits of color. While the Targa
format originated with Truevision's hardware, it has migrated to
many other applications. It's probably the most universally sup-
ported 24-bit file format for PC applications. Unlike TIFF, for
example, it's subject to relatively few variations. Software that
reads Targa files should be able to read all Targafiles.

The default extension is TGA.

Supporting Platformsand Applications

Thisformat is supported by numerous applications on awide range
of platforms.
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PMView Support

The Targafile format recognizes over a dozen subfile formats,
some of which are more widely used than others. We have chosen
to only support the formats that are actually used for general image
exchange, that is the formats specified in the official Truevision
TGA File Format Specification, available from Truevision Inc. on
request. PMView supports the following most popular versions of
the Targaformat: 1, 2, 3, 9, 10, and 11. Again, if PMView falsto
load afile that you need, please contact us so we can try to support
your file's format in our next release.

Supported Targa file subfor mats:

1 isuncompressed, color-mapped images with 16, 24, or 32-bit pal-
ette entries

e 2isuncompressed RGB images with 15, 16, and 24-bit support
e 3isuncompressed grayscale 8-hit (256 shades) support

* 9isRLE color-mapped images with 16, 24, or 32-bit palette
entries

e 10isRLE RGB with 15, 16, and 24-bit support
e 11iscompressed grayscale 8-bit (256 shades) support

Supported Targa file descriptors:

* Image orientation: Top, Bottom, Left, Right

* Raster format: Non-interlaced, 2-pass interlaced, 4-pass inter-
laced

Targaand TGA are registered trademarks of Truevision Inc.
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Tagged Interchange File Format (TIF)

General Description

This format is suitable as a generalized format for cross platform
image exchange since applications for processing TIFF images are
available on most platforms. Beware! Many applications only han-
dleasmall subset of the formats specified in the TIFF specs. Don't
take for granted that an application will be able to read the files you
savel

The default extensionis TIF.

Supporting Platforms and Applications

hisformat is supported by numerous applications on awide range
of platforms.

PMView Support

PMView provides full Baseline support conforming with the TIFF
6.0 specification and supports the following TIFF Extensions:

e CCITT hilevel encodings (RLE, FAX3, FAX4)
e LZW compression and differencing predictor
*  New JPEG compression (JPEG-in-TIFF)

* Deflate compression (ZIP-in-TIFF)

* Tiledimages

* CMYK images

* RGB image colorimetry

* YCbCr color

e L*A*B* color

e QOrientation
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The TIFF LZW compression/decompression included in this soft-
wareislicensed under U.S. Patent No. 4,558,302 and foreign coun-
terparts.

TIFF(tm) is atrademark of Aldus Corporation.

WAP Bitmap (WBMP)

General Description

The Wireless Application Protocol Bitmap Format (WBMP) is
designed for use with applications that operate over wireless com-
munication networks. The WBMP format is commonly used in
mobile phones (WAP phones) and enables graphical information to
be sent to the handset..

The default extension is WBMP.

PMView Support

PMView supports reading and writing of Type 0 WBMPfilesin
accordance with the Wireless Application Environment Specifica-
tion Version 1.2 (November 1999).

Wordperfect Graphics (WPG)

General Description

The WordPerfect Graphics (WPG) file format is a creation of
WordPerfect Corporation specifically for use with itsline of soft-
ware. WPG files are capabl e of storing both bitmap and vector data
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and may have up to 256 colors. It is aso possible to store Encapsu-
lated Postscript code in aWPG file.

The default extension is WPG.

Supporting Platformsand Applications

WordPerfect and other word-processing programs under MS-DOS,
Microsoft Windows, Maclntosh, and UNIX

PMView Support

PMView supports WPG versions 5.x. Thisversion of PMView only
reads files that contain raster graphics. WPG files with vector
graphics or PostScript cannot be read in this version of PMView.

X Bitmap (XBM)

General Description

XBM isasimple monochrome text based bitmap format that is pri-
marily intended for storage of cursor and icon bitmapsfor usein the
X graphics user interface. The datais formatted and stored asaC
languagefile and can directly be compiledinto a software program.

Supporting Platformsand Applications

This format is popular under UNIX for storage of icons.

PMView Support

PMView reads X10 and X11 X Window Bitmaps. The X10 format
is obsolete and consequently PMView will only save XBM filesin
the X 11 format.

120 Using PMView Pro



X Pixmap (XPM)

When reading XBM files, PMView scans the first 20 rows and
seeks for the width, height, and image data. PMView tries to find
the following definitions:

#define FOO_width
#define FOO_height
static char FOO_hitg] = {

where FOO is the name of the bitmap.

If PMView cannot find these definitions within the 20 first rows of
thefile, it will stop searching and not accept the file asavalid
XBM file (though it is still possible that it is valid). The file may,
for instance, have more than 20 lines of C language source code
before the definitions and bitmap data. If thisis the case you can
edit the file with a standard text editor and move the bitmap defini-
tion to the beginning of thefilein order to make PM View recognize
it asan XBM file.

X Pixmap (XPM)

General Description

XPM isatext based bitmap format that is primarily intended for
storage of color cursor and icon bitmaps for use in the X graphics
user interface. The datais formatted and stored asa C languagefile
and can directly be compiled into a software program.

Supporting Platformsand Applications

Thisformat is popular under UNIX for storage of color icon bit-
maps.
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PMView Support

PMView supports XPM versions 1, 2, and 3. Colors may be defined
by name or by RGB value (4, 8, or 12-bit/component). HSV is cur-
rently not supported. XPM version 2 and 3 files begin with a com-
ment (usually /* XPM2 C*/ for version 2 filesand /* XPM */ for
version 3files).

XPM1 notes

When reading XPM1 (version 1) files, PMView scansthe first 20
rows and seeksfor thewidth, height, color count, and characters per
pixel definitions. PMView uses the following definitions when
reading XPM1 files:

#define FOO_width

#define FOO_height

#define FOO_ncolors

#define FOO_chars per_pixel
static char * FOO_colors[] ={ ...}
static char * FOO_pixeld[] ={ ...}

where FOO is the name of the pixmap.

If PMView cannot find the first four definitions within the 20 first
rows of thefile, it will stop searching and not accept thefileasa
valid XPM1 file (though it is still possible that it isvalid). Thefile
may, for instance, have more than 20 lines of C language source
code before the definitions and bitmap data. If thisis the case you
can edit the file with a standard text editor and move the bitmap
definition to the beginning of the filein order to make PMView rec-
ognizeit asan XPM1 file.
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XWindow Dump (XWD)

General Description

The XWD (X Window Dump) format is used specifically to store
screen dumps created by the X Window System.

The default extension is XWD.

Supporting Platformsand Applications
UNIX X Window.

PMView Support

There are currently 6 different image classes; StaticGray, Gray-
Scale, StaticColor, PseudoColor, TrueColor, and DirectColor.
PMView isableto read all these types. Supported pixmap formats
are XY Bitmap, XY Pixmap and ZPixmap. For XY Pixmaps and
ZPixmaps PMView accepts a depth of 1 to 16 pixelsfor grayscale
and colormapped XWDs, and 1..32 pixels for color XWDs.
PMView handles both chunky (ZPixmap) and planar data (XY Pix-
map). PMView reads X10 and X11 X Window dump files.

Field PMView Support
File Version X10 (06h), X11 (O7h)

PixmapFormat XY Bitmap (00h), XY P-
ixmap (01h), and ZPix-

map (02h)
PixmapDepth 1..32 hits
BitsPerPixel 1..32 bits
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Field PMView Support
BitmapUnit 8..256 bits

VisualClass StaticGray (00h), Gray-
Scale(01h), StaticColor
(02h),PseudoColor
(03h), TrueColor (04h),
and DirectColor (05h)

UU-encoded and XX-encoded Files
(UUE and XXE)

If PMView detects afile that has been UUEncoded or X XEncoded
it will automatically decode the file. The decoding will be done
transparently, thus it does not require a separate reading or process-
ing step. This means that encoded files can also be displayed pro-
gressively if the graphic format in thefile allows it (e.g. GIF, JFIF,
PNG, etc.).

Base64-encoded Files (MIME)

If PMView detects afile that has been Base64-encoded it will auto-
matically decode the file. The decoding will be done transparently,
thus it does not require a separate reading or processing step. This
means that encoded files can also be displayed progressively if the
graphic format in thefile allowsit (e.g. GIF, JFIF, PNG, etc.).

The Base64 encoding schemeis used by MIME aware software. A
MIME message can contain multiple files. However, PMView only
reads the first Base64 encoded image in the file. If the file contains
several images you need to use atext editor and split the file into

severd filesif you want PMView to read thefiles. In thiscaseitis
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probably more convenient to use a MIME reader that is ableto
automatically extract al the parts of the message for you.

Multi-page File Formats

PMView can read multi-page files. Multi-page files arefiles that
can hold two or more images in the same file. Among the formats
that can be handled by PMView, the following can hold multiple

images.

e (OS/2 Bitmap (BMP)...

¢ Windows Cursor (CUR)...

« DCA/Intel DCX (DCX)...

e Graphics Interchange Format (GIF)...

e 0OS/2Icon (ICO)...

* Windows Icon (ICO)...

e OS2 Pointer (PTR)...

e Tagged Interchange File Format (TIF)...

Please note that this version of PMView isnot ableto savefiles
with multiple pages. Only the currently viewed page will be saved.
However, we are planning to add support for writing multiple
pages. If you have any suggestions for this feature, please let us
know.

Automatic File Recovery

Files that have been electronically transferred (e.g. via Internet)
may have an unknown header that was added by one of the pro-
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grams that the sender used when he created and/or transferred the
file. The extrabytes at the beginning of the file makes the file unus-
able because applications cannot recognize the file as an imagefile.
For instance, a GIF file should begin with the letters "GIF87a" or
"GIF89a". If thisisn't true, the fileisn't avalid GIF and cannot be
read.

If PMView cannot recognize afile as one of the readable file for-
matsit will automatically scan thefilefor any of the formats below.
Thus PMView will be able to read a GIF or JFIF file with an
unknown header (e.g. 3,733 bytes of trash at the beginning of the
file).

The following formats can be recovered from files with an
unknown header:

e Graphics Interchange Format (GIF)

* JPEG File Interchange Format (JPG)
* Adobe Photoshop Document (PSD)

¢ Portable Network Graphics (PNG)

e Tagged Interchange File Format (TIF)
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CHAPTER 6 FI Ie
Converson &
Sripts

This chapter will explain, in detail, the features and functionality of
PMView Pro’s file conversion and script utilities using examples
and step-by-step instructions.

Thumbnail Creation (Using Scripts)

We will begin with a step-by-step tutorial on creating thumbnails.
Detailed information about the dialogs follows later in this chapter.

Choosing images

Thefirst step isto locate the images that need thumbnailing. Using
the PMView File Open dialog, you can select the images using
Ctrl+left click or access the Popup menu to turn on "sticky select".
Once you have selected your images, right click on any one of the
images and select ' Convert...’

The Convert dialog

Thefirst step of the convert dialog is to choose a script that should
be used. If you are only converting from one format to another, you
can select <None>. Otherwise, choose New to activate the Script
Editor dialog. From the Script Editor, you can set al possible
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options for this conversion. Thefirst option isto give your script a
name. In this case, the script will be named ' vacation thumbnails
because | will useit frequently to create thumbnails of my vacation
photos.

Now | am ready to choose the Oper ations from the selection area
on theright. | will begin by selecting ’ Set Output Format’, * Set
Output Directory’ and ' Resize’ al at once by using Ctrl + left-click.
Oncethey are al selected, simply click the’Add’ button to move
them into the script box on the left.

Once you have added the operations to your script, you now need to
set the parameters for those operations. From the Scripts box,
select Set Output Format. In the Parameter s field below, you will
see another dialog appear that allows you to select aimage format.
Thisistheformat that the fileswill be converted to during the script
process. Remember that you can set the 'Options' of certain file
formats if the Options button is active.

The next selection, Select Output Directory, will allow you to set
the directory images converted using this script will be saved to.
Input the full path to your save directory, or select the checkbox to
use the directory of the original image as the target save location of
the new converted images.

Thefinal operation isthe Resize option. Highlight this option and
you will be presented with the basic PMView size options. You can
specify the resolution of theimagein pixels. For thistutoria, | have
selected 100x100 sizing and checked the’ Resample Pixels' option
only.

If the script is one that you will use frequently, be sure to check the
box in the lower right to include this script on the Quick Script
menu!

Click OK to save your script. Now you should see the Convert dia-
log again, only now the output format and directory options are
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disabled since they will be set by the active script. Switch between
<None> and vacation thumbnails to see the difference.

The only option left on that menu should be to choose how
PMView should react to files that already exist. Set the appropriate
options and press Convert to begin the script. PMView will imme-
diately begin converting the images in the background and you can
begin or continue other operations within PMView.

The next time you need to make 100x100 pixel images, simply
select the images from the File Open dialog and right click. You
will then be able to select 'vacation thumbnails' from the Quick
Script menu and instantly have thumbnails for your images.

File Conversion

PMView Pro’s built in file conversion utility makesit simple to
convert your files from one format to another. PMView Pro sup-
ports over 40 different file formats as discussed in the previous
chapter, and can convert to and from those formats. Many of the
formats provide options for what information should be preserved
from one format to another just the same as when saving files. The
ability to convert multiple files at once and the addition of pre-
defined scripts to the process make this utility one of the most pow-
erful features of PMView Pro.

How to convert file(s)

Files can be converted individually or in batches; from within
PMView Pro or from the command line.
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e SingleFile Conversion
From the main window...

To convert asinglefilethat is aready open inside the PMView Pro
window, simply select Convert... from the File menu. This will
open the File Convert dialog window with the various options.

From the File Open Container...

If thefile has not been opened, you can access the conversion menu
from the File Open Container as well. Simply select the file that
you wish to convert and right click to access the pop-up menu.
From the menu, select the Convert... option.

From the command-line...

In order to use the command-line for file conversion, you will need
to have a script that defines the options that should be used. Scripts
can be accessed, created and edited from the File Convert dialog
window. Once you have created your script, save it to the Scripts
directory of your PMView directory and typein the following at the
command-line;

path_to PMVIEW.EXE /scr=myscript file,jpg

Assuming the script was saved to PMView Pro’s Script directory,
the filename (myscript) issufficient. If you have saved the scriptsin
another directory, you will need to specify the correct path to the
script
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e Multiple/Batch File Conversion
From the File Open Container...

To convert multiple files from the FOC, simply select more than
onefileusing Ctrl + click or the Sticky Select option from the FOC
Popup Menu. Once you have selected all of the images to be con-
verted, right click on any of the selected images and select Con-
vert... from the FOC Object Menu.

If you wanted to use a previously created script, smply choose
Quick Scripts from the FOC Popup Menu and select your script.

From the command-line...

Using the command-line option, you can specify entire directories
and use wildcards to determine the files that should be converted.
This does require that you have created a Script file with PMView
prior to conversion. To convert al JPG filesin adirectory, you
would input the following at the command-line:

path_to PMVIEW.EXE /scr=myscript C:\photos\*.jpg
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CHAPTER 7 Frmumtly
Asked

Questions

This chapter answers some common questions we get and helps
you solve problems that you may encounter while using PMView.

General Questions

How do | convert filesfrom one format to another?

Choose "File->Open" from PMView's menu bar. Thiswill open up
the File Open diaog. Right click on thefile you want to convert and
choose, for instance, "Convert to->GIF"

PMView's menu bar has disappeared. How do | get it back?

Right click on PMView's main window. Choose "View->Show-
>Menu Bar" from the resulting pop-up menu.

How do | get rid of the annoying About dialog that always pops
up when | start PMView?

If you haven't registered PMView yet, register! In the unregistered
version of PMView you cannot dismiss the dialog until 5 seconds
has elapsed. Visit the PMView website for registration information.
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Why do desktop color s change/flash whenever | load an image?

Thisis caused by the pal ette manager when it remaps system col-
ors. If you'rewilling to sacrifice color quality, you can fix this prob-
lem by turning off the palette manager; Uncheck Use Paette
Manager on the Palette page in PMView's options notebook. Alter-
natively, you may consider setting your display to a mode that pro-
vides more than 256 colors, if possible.

Why does/doesn't PM View ask for confirmation before deleting
afile?

PMView will ask for file delete confirmation in accordance with the
setting on the Confirmations page in PMView's Options Notebook.

File Open Container (FOC) Questions

What isthe File Open Container (FOC)?

The FOC isthelarge, initially white, rectangular areain the lower-
right corner of PMView's File Open window. To see the File Open
window, either select "File->Open" or type Ctrl+O.

The FOC is a standard container, which means that you change
its view, drag and drop things to and from it, and resize it. (To do
thelast, resize the window and the FOC will aso beresized.) You
can also display a popup menu for the FOC and for each image
insideit. Finally, you can rename an image by clicking on the file-
name.

How do | bring up the FOC pop-up menu?

The usual way: Right-click inside the container but not on one of
theimages. A menu will pop up. If the top item on the menu is
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"Open", then you have the menu for one of the images; try againin
another location.

If you arein Flowed view, try right-clicking under the bottom row
of icons. If you arein Detail view, right-click on one of the column
headings, e.g., on top of the word "Name." Again, thisisal as
usual.

How do | select morethan oneimage?

The usual ways. You can drag arectangular area, and all theimages
that touch the rectangle will be selected. (If you try to drag the rect-
angle "outside" the FOC, the FOC will automatically scroll.) You
can click on the first image you want and Ctrl+click on the second
and subsequent ones. If you want to select a bunch of imagesin
order, you can click on thefirst one, then shift-click on the last one,
and al the images between them will be selected. You can also type
Ctrl+/ to select al the imagesin the current directory.

There's also one other "unusual" way: If you don't like having to
hold down Ctrl, then bring up the FOC popup, click "Select”, and
click "Sticky Select". While Sticky Select ison, you don't need to
hold down Citrl to add images to the selection. (To deselect while
you'rein Sticky mode, click the image a second time.)

Why is PM View so slow at putting imagesinto the FOC? How
can | speed it up?

In Normal View mode, PMView hasto |oad alot of information for
each image beforeit addsit to the FOC. It hasto load the thumbnail
and standard icon for each image. It aso reads enough of the image
to check its actual image format (as opposed to its filename exten-
sion) and its color depth (i.e., how many colors the image could
possibly have). It loads al this information in case you change to
Detail view, or want to sort based on thisinfo.
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If you don't need thisinfo, try Quick view instead. In Quick view,
you can only see (and sort on) file names, sizes, dates, and times.
But if that'sall you want, Quick view istheway to go, especialy on
slow drives (such as CD-ROMS).

Whew! What are all those View choices?

The best way to figure out the Views is to experiment, and to look
at page 44.

How can | sort images?

Bring up the FOC popup menu and click "Sort". By defaullt,
PMView sorts by filenames. If you want to change this defaullt,
click the arrow to the right of "Sort" and pick the sort type you
want. Note that some types of sorts are not available in Quick
mode. For details on the sort options, see page 46.

I sthereanything else on the FOC popup?

Yes -- the "Refresh”" command. This re-reads the current directory
and updates the FOC display. Images will be sorted using the cur-
rently selected method. Use "Refresh” if you're using another pro-
gram (or session) to add (or change) images.

Sideshow Questions

How do | create a slideshow?

Select "File->New->Slideshow" to take you to slideshow mode.
Select File Open, and drag the files you want to PMView's main
window.
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In fact, you can skip the "File->New->Slideshow". If you drag
more than onefile at once to PMView's main window, it will take
you to slideshow mode (if you aren't there already) and add these
filesto the slideshow.

How can | changethe order of theslides?

Drag them around. If you drop one slide on top of another, it will be
inserted directly after that slide. (Moving a slide to the beginning of
the slideshow takes two steps: First, drop it on the first slide. Sec-
ond, drop thefirst slide onit.)

How do | run a dideshow?

Choose "Run All" from the slideshow's popup menu, or type
Alt+R. (To get to the slideshow's popup menu, right-click in a
blank area of the main window).

By default, the slideshow will run full screen, and the slideshow
controller will bevisible. You will have to move to the next slide
manually, by either pressing the right arrow key, clicking the right
mouse button, or pressing the PLAY button on the slideshow con-
troller.

How can | hide or unhide the slideshow controller?
During the slideshow, type Alt+C to toggle the controller's visibil-
ity. Of course, you can aso click the close button on the controller

to makeit invisible.

To start with a hidden slideshow controller, right click in the main
window, then unselect "View->Show->Controller".

How can | quit the slideshow?

You can click your middle mouse button (if you don't have one, you
can click both left and right buttons simultaneously), or you can hit
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your Esc key. If the controller's visible, you can click the STOP but-
ton.

How can | save the slideshow?
Choose "File->Save" (or "File->Save as").

Slideshows are saved with an extension of *.SHW. Note that a
slideshow isaplain ASCI|I text file, so you can edit it with your
favorite editor. The only restriction is that you may not modify the
first line; it hasto be left exactly asis, or PMView won't recognize
the slideshow properly.

What if | don't want to run the slideshow full screen?

Right-click in the main window, then select "View->Preferences’.
This takes you to the options notebook. Go to the slideshow page
and turn off "Run full screen".

During the slideshow, you can toggle in and out of Fullscreen mode
by typing F3, or |eft double-clicking on the image.

What if | don't want to have to moveto the second slide manu-
ally?

Right-click on thefirst slide to bring up its popup menu. Click " Set-
tings'. In the group that says, "Advance to next image," choose

"Automatically after" and specify anumber of seconds. Then, when
you run the dlideshow, PMView will move to the second slide after

that many seconds.

What if | don't want to haveto moveto thethird slide manu-
aly?

Right-click on the second slide to bring up its popup menu, then
follow the instructions above.
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Hey! If | want each dlide to stay on for 5 seconds, do | haveto
change every dlide by hand?

You can, but there's an easier way. Set up thefirst dide for five sec-
onds. Select all the other dlides (you can type Ctrl+/ to do this).
Right-click on the first slide, then choose "Copy Settings' (don't
click on the arrow). Choose OK, and all the slides will now be auto-
matic with a 5-second delay.

What if you only want a 5-second delay on thefirst, third, and fifth
slide? Set up thefirst, select the third and fifth (via Ctrl+left click,
as with any other container) and right-click the first slide's " Copy
Settings' command.

What aretheother settingsfor adide?

The "Notes" option lets you type notes about the slide. These notes
will be saved when you save the slideshow.

If you select "Display Notes', your note will be displayed in awin-
dow while that slide is shown.

You can copy any or al of these settings by selecting "Copy Set-
tings', as explained in the previous question. To choose which set-
tings get copied, click on the arrow to the right of " Settings", and
select the settings you want to copy. (Thisis much easier to do than

say.)
What arethe other commands for aslide?

"Remove" will take the dide out of the dideshow. "Run" (on a
dlide, not on the main window background) will let you "run" just
that dlide (to check its note, for example).
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PMView for Windows Questions

How Do | Register PMView?

The PMView Pro evaluation version cannot be converted to a
licensed version without first purchasing alicense and downloading
the required files. Unlike previous versions, registration will not be
done by license key but by full version download.

Why isprinting not working?

Printer driver problems are common on Windows 95/98. If you
have a prablem printing from this version of PMView, we recom-
mend that you uninstall and reinstall the printer driver. This usually
solves the problem. You can also try the Reset option on the
PMView Print dialog. Right-click the Setup button and select
Reset... to reset the PMView print options.

How do | change the background color of PMView’s main win-
dow?

1. Select "Start->Run" in Windows.

2. Type"REGEDIT" and press enter.

3. Openup "HKEY_CURRENT_USER->Software->Nielsen
Software->PM View->3.0->Window".

4. Right click on "Window" and select "New->DWORD value".

5. Type "BackgroundColor" in the field and press enter. Then dou-
ble click on "BackgroundColor".

Now typein the color value. It should bein 6 digit hexadecimal for-
mat RRGGBB. For instance FFFFFF is white, FFO000 isred and
OOFF00 is green color. Click OK. Now PMView will use the color
you specified.
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PMView for OS2 Questions

How Do | Register PMView?

The PMView Pro evaluation version cannot be converted to a
licensed version without first purchasing alicense and download-
ing the required files. Unlike previous versions, registration will
not be done by license key but by full version download.

How Do | Make PMView The Default Viewer?

Assuming that you use the default installation settings when install-
ing PMView, thisis done automatically by the installer. A reboot
may be required for the changesto become effective. If you haven't
rebooted, do it. If you're using Object Desktop you aso need to
deselect the " Automatically view when identified" option on the
"DataFiles" page of the "Master Setup" notebook in Object Desk-
top.

Why am | getting screen corruption?

If you see screen corruption, the first thing you should try in most
casesisto try upgrading or reinstalling your display drivers. Con-
tact PMView support with your system information if problems
continue.

| upgraded my Adaptec SCSI driver and now my system locks
up. What can | do?
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If you have upgraded your Adaptec SCSI driver and are having
problems with lockups (especially during scanning), it is recom-
mended that you revert to the drivers on the Warp 4 CD-ROM.

How can | fix printing problems?

Printer driver bugs are not uncommon. If you have a problem print-
ing from this version of PMView, we recommend that you down-
load the most recent printer driver from the IBM device driver
repository at the following URL :

http://service.software.ibm.com/os2ddpak/index.htm

Note that the OS/2 FixPak upgrades usually DO NOT upgrade your
printer driver to the latest fix level. Unless you know for sure that
you are using the latest release, we recommend that you double-
check it.

Itisalso possiblethat your printer driver installation is corrupted. If
you know you are using a printer driver that is supposed to work,
yet it does not work with PMView, then try to uninstall and reinstall
the printer driver. We have encountered a couple of situations
where asimple reinstall of the driver solved the problem.

Another possible solution would be to use the PMView application
to Reset the selected printer. To reset the printer, open the PMView
Pro print dialog and right click on the Setup button at the bottom of
the window. Click the Reset option to reset the print options.

Why is PM View not working with a particular application?

The following applications need a special configuration with
PMView Pro:

o X-it

If you select X-it's right mouse button to "edit popup menu"
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(default), and add 'static' as a control for the edit menu to popup
over (under xit->options->menu->popup menu over these
areas) (not the default), then PMView's popup menu will not
show in the main window.

Solution: Do NOT check the 'static' control in X-it's menu
options dialog. Alternatively, you can add PMView to X-it's
exception list. Future solution: Upgrade to X-it v2.6 that solves
the problem.

e CandyBarz
PMView's title bar is blank.

Solution: Make sure that the CandyBarZ option "Enable
PMView fix" isNOT checked. This option is needed for older
versions of PMView only.

¢ MSE

Using M SE to emulate a Button 1 double click does not work
correctly if the "Mover" tool in PMView is used. The Mover
tool invokes OS/2 for moving the window and M SE isunableto
provide the correct double clicking emulation required by OS/2.

Solution: Change the tool in PMView to Scroller or Selection.
e DragText

Dragging locks up the WPS when using PMView+Drag-
Text+Netscape. Thereisaproblem with how Netscape handles
drag & drop.

Solution: The recommended workaround for thisisto take DT
out of your Startup folder and run it from a Startup.cmd file
(already supplied in your DT folder). This changes the loading
sequence for DT, and gets around the problem.
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STi TWAIN

Version 1.6.5 or newer is required. Make sure that the PMView
option "Use buffered memory transfer" is enabled (default) and
that "Unload library" is disabled (not default). Note that there
are a couple of problemsin the current release of STi TWAIN:

1. TWAIN.DLL cannot be reloaded once unloaded. To work
around this problem you need to disable the "Unload library"
option. The side effect of thisisthat once you use TWAIN with
PMView, no other application can use it until PMView is
stopped (and TWAIN.DLL unloaded).

2. Using PMView with the "Use buffered memory transfer"
option disabled will not work. STi's DLL uses amethod that is
incompatible with the TWAIN specifications.

3. DO NOT press the "Cancel" button in the scanning dial og.
Doing this will cause problems like crashing PMView with a
SY S3175 (Thisbug only appearsin STi TWAIN 1.6.10)

STi Inc. isaware of the problems and will hopefully fix themin
the next version.

CFM TWAIN

There are two known bugs in the current version of CFM
TWAIN:

1. Do NOT press the Escape key in the CFM "Overview" win-
dow. Doing thiswill result in a SY S3171 exception in
PMMERGE.DLL. The problem appliesto all and any program
that uses CFM TWAIN. Even CFM's own ScanWorks
(SWOS2.EXE) program will crash when pressing Escape in the
"Overview" window.

2. Thereis a problem with using the PMView TWAIN option
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"Close user interface after scanning”. CFM TWAIN only saves
its current settings when the TWAIN dialog is manually closed
with the "Finish" button. New settings will not be saved if the
interface is closed by pressing the "Cancel" or closed by ALT-
F4. The same goes if the interface is automatically closed by
PMView.

e Object Desktop

Occasionally parts of the control center of OD2 flicker through
when loading the next file. This happensif PMView's main win-
dow is maximized.

This problem only occurs when using Object Desktop. It is
caused by the fact that we need to workaround an OS/2 bug.

Here are the specifics:

Ever since the very first OS/2 Warp 3 beta, the OS/2
WinCalcFrameRect API has been broken. If thisAPI iscalled
when an application is minimized, the application will crash. If
it is called when an application is maximized, weird things start
happening to the application's menu bar.

The workaround for this problem isto disable window drawing,
set the application's window to normal (non-minimized/maxi-
mized) state, call WinCal cFrameRect, restore the window's
original minimized/maximized state and eventually enable win-
dow drawing.

On abasic 0S/2 system this will work without flicker. Unfortu-
nately Object Desktop ignores that PMView has disabled win-
dow painting and causes painting to be done anyway, hence the
flicker.

We have no remedy to this problem. The problem can be fixed
by Stardock if they optimize their window handling algorithm.
Evenif IBM fixesthe OS2 bug it will not help you (however
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this will let us remove the workaround in a future version of
PMView, which will of course solve the problem).
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